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Preface

About This Book

This book provides step-by-step examples of basic tasks
common to any application you create with the 4th
DimensionTM program . The tutorials take the point
of view that you are somewhat familiar with the
MacintoshTM personal computer and with database design,
so that your primary interest is in learning to use 4th
Dimension .

In the early chapters, every step is explained in careful
detail . Later chapters assume that you don't need repeated
explanations of topics that have been covered earlier .
However, cross-references make it easy to find the
complete instructions .

Feel free to skip around in this book . The chapters are
designed to be followed in order, but you will find them
useful even if you don't follow every chapter or task
step by step . Each chapter stands on its own, so that you
can use this book to learn what you need when you need
to learn it. The chapter title and the first paragraphs in
each chapter describe what it covers .

xi



Definitions of some terms,
remarks, and references to
other 4th Dimension documents
appear in the margin .

x ii Preface ; About This Book

Chapter 2, "Designing a Database With 4th Dimension," is
an introduction to databases in general and to 4th
Dimension features in particular . The following chapters
are all in tutorial format . Chapter 3, "Looking at a
Finished Application," takes you through a completed
application, similar to the one you will be creating in the
remaining chapters . Then, starting with Chapter 4,
"Creating a New Database," you begin setting up the
personnel database from the very beginning . Each chapter
builds on the information in the previous chapter . By the
end of the book, you will have practiced the basic skills
necessary for creating a database .

Apple Computer, Inc, provides guidelines for designing
the interface of programs you can create with 4th
Dimension, called the Human Interface Guidelines . If you
are designing applications for others to use, it is a good
idea to consult this book for practical and effective
interface suggestions .

Human Interface Guidelines is available from Apple
Programmer's and Developer's Association, 290 SW 43rd
St ., Renton, WA 98055 .

What to look for
The tutorials contain specific instructions for you to
follow and general information that explains the program .
Usually, each instruction is followed by a short comment
or explanation .
1 . Instructions are numbered .

Explanations and comments about instructions appear as
separate indented paragraphs below the numbered
instructions .



•.• Special notes: Programming issues and comments about the
operation of some of 4th Dimension's features are set off from
the main text like this . If you are following the tutorial, don't be
distracted by these notes . They point out complexities that
can't be covered in a tutorial .

What you will not find
Many immediately accessible 4th Dimension features are
covered in this book . But this represents only part of
what 4th Dimension offers . The tutorials present one
approach to using the program that has been tested and
found effective for learning .

Basic aspects of 4th Dimension are introduced step by
step in each tutorial . In some cases, a particular topic is
discussed in more detail under the heading "Further
Information ." For example, the tutorial in Chapter 4,
"Creating a New Database," introduces the three basic
field types (Alphanumeric, Date, and Real Numbers) with
a step-by-step approach . The remaining field types are
then described in a separate section .

Everything about 4th Dimension is explained in the 4th
Dimension User's Guide, the 4th Dimension Programmer's
Reference, and the 4th Dimension Command Reference . If
you want to set out on your own, with these books as
your guide, feel free to do so .

What you will not find
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Preface ; About This Book

How the continuing example works
The tutorials use the example of the (fictional) Consumer
Products International Company . You have been asked to
create a database application for the personnel
department. This application will keep track of employees
and departments within the company .

Sample files for these tutorials are on the 4th Dimension
Examples disk. A database is provided for each chapter,
so that you can follow the instructions no matter which
chapter you start with . You should copy these files to
your hard disk and use the copies with the tutorials .



Chapter 1

Introducing 4th Dimension



2 Chapter 1 : Introducing 4th Dimension

4th Dimension makes it possible for application designers
to create powerful database applications that take full
advantage of the Macintosh interface .

This book, the 4th Dimension Tutorial, provides a quick
overview of the program in tutorial form . It describes
how to begin using 4th Dimension, introduces the
different parts of the program, and then shows you step
by step how to set up a fairly substantial application : a
personnel tracking and reporting system .

You will find everything you need to know about the
•

	

Macintosh Plus computer and its system files in
Macintosh Plus, the owner's guide . In particular, it
teaches the basic techniques that you need to operate all
Macintosh applications . If you are new to the Macintosh,
be sure to review the owner's guide .

To use the 4th Dimension Tutorial, you need to know
how to
•

	

click to select places on the screen and start actions
•

	

drag to select objects and move them around
•

	

choose to use commands from the menus in the menu
bar

What you'll need
Everything you need to run 4th Dimension on a
Macintosh Plus computer is included in your package .
Here is a checklist of the equipment you need to run the
program and of the disks containing the software .



Hardware

The minimum requirement to operate 4th Dimension is a
Macintosh 512Ke computer . However, the recommended
configuration is as follows :
•

	

a Macintosh Plus computer
•

	

a hard disk drive
a a printer
:• Note. A printer is optional for learning how to use 4th

Dimension . In practice, however, database applications need
printers regularly. 4th Dimension requires that your system
contains a printer driver .

You should always work with the latest System and Finder
software . 4th Dimension is designed to work with System 4 .1 or
later and Finder 5.4 or later .

Software
Your 4th Dimension package contains several disks .
These include the program itself and example disks
containing sample databases to help you learn the
program :
•

	

The 4th Dimension Program disk contains the entire
4th Dimension program . You will copy the contents of
this disk to a folder on your hard disk . Afterward, you
should store this disk in a safe place .

•

	

The 4th Dimension Utilities disk has special programs
that allow you to duplicate database structures and to
repair damaged databases .

•

	

The Examples disk contains sample database files for
use with this book and for independent study .

What you'll need
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4 Chapter l : Introducing 4th Dimension

Learning 4th Dimension
You can learn everything you need to know about 4th
Dimension from these items in your 4th Dimension
package :
1 . This book, 4th Dimension Tutorial, gives you a guided

tour of the basic features of 4th Dimension right on
your computer, introducing you to the personnel
database application at the same time .

2 . The disk of sample applications provides working
examples of 4th Dimension databases, including
carefully annotated custom procedures . You can use
these procedures as models for understanding 4th
Dimension's built-in procedural language .

3. 4th Dimension User's Guide provides explanations
and step-by-step procedures for using all of 4th
Dimension's features .

4. 4th Dimension Programmer's Reference and 4th
Dimension Command Reference are your technical
reference manuals for the program . The first explains
how to develop applications with 4th Dimension and
the second provides a complete description of every
command.

Start up the program and follow a chapter or two of this
book . You will get a feel for the different parts of the
program and how to move among them . How you then go
about learning to use 4th Dimension for your own work
depends on your experience and the way you prefer to
learn a new program .



Starting 4th Dimension
You start 4th Dimension after you have installed the
program on your hard disk . You then have the choice of
creating a new database or opening one that already
exists .

Installing the program on a hard disk

1 . If you want to keep 4th Dimension in a separate folder,
create a new folder, rename it, and open it .
You will copy the program into this folder .

2. Insert the 4th Dimension Program disk into the
internal drive of your Macintosh .
After a few seconds, the disk icon appears on the
desktop .

3. Double-click on the 4th Dimension disk icon to open it .
4. Copy the program into the folder you just created .

You are now prepared to run 4th Dimension from your
hard disk .

5 . Eject the 4th Dimension Program disk and store it in a
safe place .
In the rare case that your hard disk is damaged, you
can restore 4th Dimension from the original disk .

6 . Copy the 4th Dimension Utilities to your hard disk .
7 . Copy the sample databases from the Examples disks to

your hard disk as well .
This preserves the original form of the sample
databases on the original disks . Instructions in this
book assume that you have the databases on your hard
disk in the same folder as the 4th Dimension program .

Starting 4th Dimension
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6 Chapter 1 ; Introducing 4th Dimension

Starting the program for the first time
1 . Double-click on the 4th Dimension program icon .

4th Dimension displays the Welcome screen .

Figure 1-1
The Welcome screen

If there are no 4th Dimension databases in the same
folder as the program itself, the Files area does not
show any database names and the Open button is gray .
If you have copied the sample databases to the same
folder as the program, the database names appear in
the Files area .

2 . To create a new database, click New .
4th Dimension displays a dialog box for you to enter
the name of the new database .
This step and subsequent actions are covered in detail
in Chapter 4, "Creating a New Database ."



3 . To open a database that already exists, select the

database and click Open .

This step and subsequent actions for opening a sample

database are covered in detail in Chapter 3, "Looking

at a Finished Application ."

At this point, you can proceed in one of three ways :

•

	

To read an introduction to database design and 4th

Dimension features, go to Chapter 2, "Designing a

Database With 4th Dimension ."

•

	

To look at a completed sample database, go to

Chapter 3, "Looking at a Finished Application ."

•

	

To start building a database from scratch, go to

Chapter 4, "Creating a New Database."

Saving and backing up your work

When you create a database, 4th Dimension automatically

saves the structure, layouts, and procedures when you

close the window you used to create these parts of the

database . You can manually save these parts of the

database while working on them by using menu commands

in the File menu .

When you enter data into the records, the information is

automatically saved when you click OK or Enter .

You should always keep a backup copy of your databases

on a separate hard disk, a tape storage device, or a floppy

disk . You should make additional copies of important

databases and store them in a different location . Although

rare, problems that cause loss of data can be devastating

unless your data is backed up .

Starting 4th Dimension
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8 Chapter 1 ; Introducing 4th Dimension

The best way to ensure that you have a backup copy is to
develop a routine for your work . At the end of every
session, for example, copy the files you have been
working with to another folder. Then every week, copy
your data files to a disk .

Anyone who uses a computer for any length of time soon
learns the importance of having backup copies of
important programs and files . Don't learn this lesson the
hard way!



Chapter 2

Designing a Database
With 4th Dimension
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Chapter 2 ; Designing a Database With 4th Dimension

With 4th Dimension, you can write custom database
applications-applications designed specifically to serve
your own information needs or the needs of your client
or company .

This chapter reviews the basics of designing a database
and how they apply to 4th Dimension . If you have
previously created database applications, this chapter will
serve to introduce you to the way 4th Dimension uses
familiar terms and concepts. If you are new to database
applications, you will find it a useful introduction to the
kinds of problems 4th Dimension can solve .

What is a database?
A database is a collection of information organized in
files for easy access . The telephone book is a good
example. The information consists of names, addresses,
and telephone numbers ; it is organized in alphabetical
order so that you can find the information you need
quickly and easily.

As Figure 2-1 shows, the information in a file is stored in
fields in records . A field is a category of information,
such as an address . A record contains all the field
information for a unique instance . For example, a
telephone book record for one person contains that
person's name, address, and phone number .
A database contains one or more files. Usually, each file
has a different set of fields . In a sense, a telephone book
is a two-file database, containing the white-pages file and
the yellow-pages file . Both files are organized
alphabetically: the white pages by last name ; the yellow
pages by category of business and then by company name
within each category.



Records and fields can be represented in many different
ways. Two of the most common representations are as a
list of records with the field names as column headers
and as a set of filled-out forms with field names next to
the fields .

Record

i i
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Addr

City

Pho

Field name

Name ~

Name

ess

ne No
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end

9990

Figure 2. 1
Two ways of representing one record

What is a database?
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Chapter 2; Designing a Database With 4th Dimension

Kinds of database applications

An application is a database set up to solve specific
problems. The telephone book is an example of a simple
database application. People use it to look up telephone
numbers or addresses .

Applications are created for specific purposes . Each
business question that can be answered by gathering,
storing, manipulating, and disseminating information can
be solved by using a database .

Large-capacity databases keep track of transactions . Each
time you use a credit card, you start a process that
results in information about that transaction being
entered into a database . At the end of the month, the
program that runs the application adds current charges,
checks on past due accounts, totals the current bill, adds
the taxes, and prints an invoice complete with mailing
address .

Other databases are used to analyze information ; to
discover trends and relationships among different kinds
of information . The daily stock reports are a good
example of information that is analyzed and presented as
a graphic image so that trends can be seen . Sales
information is often divided and summarized over parts of
the whole, so that a manager can see, for example, the
total profit per sales region, per product, per month .

Database applications are used in all areas of business .
They include accounting, inventory control, time and
billing, project planning, and direct-mail advertising .
With 4th Dimension's flexibility and procedural language,
you can create any kind of database application .



Database design basics
When you design a database application, you typically
concern yourself with four major areas : input, structure,
processing, and output .
•

	

Input: what data comes into the system and how it gets
entered. In the telephone book, the information
consists of names, addresses, and phone numbers . It is
probably entered into the computer by a data entry
operator reading from paper forms. Other means of data
entry include data transmission from other computers
and reading information directly from storage on disk .

•

	

Structure: how different pieces of the information are
organized within the system . The telephone book
database has a simple structure : each record stores one
piece of information in each field . More complex
structures make it possible to store information on one
record for use by other files and records .

•

	

Processing: what kinds of manipulations and
calculations are performed on the information .
Processing includes verifying data, moving information
into different storage locations, and calculating
variables based on information entered into the system .
Processing for the telephone book database includes
sorting names alphabetically and deleting names no
longer in service .

•

	

Output: what information comes out of the system and
how it is used . Output includes reports, terminal
displays, and data transmitted to other computers . The
printed telephone book is a specific kind of output
from the electronic database that stores the
information .

What is a database?
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Linking arrow relates one field to
another

Subfile line relates a file to a
single field

Database file structures
A 4th Dimension database can have up to 99 files . You can
relate the information in one file to data in another file
in various ways to create an efficient structure for
complex information . The file structure is like the
foundation of a house : it defines the way the remainder of
the building must be organized. The file structure is the
most important result of your analysis of the information
needs for an application .
Ideally, you will design a database structure that allows
you to store duplicated information only once and to
process it only when necessary . For example, using a
multiple-file structure for an invoice application, you can
put the name, address, city, state, and Zip code in one
file ; the part number, description, and price in another
file ; and the actual transaction record in a third file . In
4th Dimension, these files can be used to save data
storage space, processing time, and data entry time .

Customers
Last Name A
First Name A
Address A
City A
State A
2IP Code A
Phone A
Order

Order
Part Number R
Description A
Price
Quantity
Amount

R
I

Figure 2-2
A multiple-file database structure
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Chapter 2; Designing a Database With 4th Dimension

Inventory
Stock Code

	

R
Units on Hand A
Description

	

A
Price

	

A

In the example shown in Figure 2-2, the Order file is a
subfile of the Customers file and is linked to the
Inventory file. The next two sections explain these
relations .



4th Dimension calls the file at
the blunt end of the arrow the
linking file; the file at the point
of the arrow is called the linked
file .

Linked files

A link between files is a way of searching for and
gaining access to information in another file based on a
common field . You employ a link to use information from
another file and to avoid duplication .
In essence, the link makes information in the linked file
available to a corresponding record in the linking file .
For example, when an order clerk enters the part number
in the Order file, 4th Dimension finds the corresponding
description and price from the Inventory file and enters
them in the transaction record . The part number
references one (and only one) record in the linked file . A
record in the linking file can display and use any of the
field information in the linked record .

Figure 2-3
A link between flies

The advantage of using a linked file is clear when you
consider how quickly new products can be added and
price changes made . Additional information can also be
used, such as the quantity of each item currently in stock .

Database file structures

	

1 5

Inventory
} Stock Code R

Units on Hand
Description

A
AOrder

Part Number
Description
Price
Quantity
Amount

Price A
A

I
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Chapter 2 ; Designing a Database With 4th Dimension

Subf lies

The subfile is a unique feature of 4th Dimension that
allows you to establish another type of relationship
within your database file structure . A subfile allows you
to attach a group of subrecords to each record within a
file .
A subfile is particularly useful to hold transaction detail
information. A good example is an invoicing application
(see Figure 2-4) . The parent file contains the main order
information (order number, date, customer's name and
address), while a subfile contains the items ordered, one
item per subrecord. The detail lines on the invoice
represent the subrecords in a subfile . They contain the
part number, description, quantity, and price .

Customers
Last Name A
First Name A
Address A
City A
State A
2IP Code A
Phone A
Order

Order
Part Number R
Description A
Price R
Quantity I
Amount

	

R

Figure 2-4
A parent file and a subfile

The subfile for the invoice detail lines can include any
number of fields-whatever information is necessary for
each item. In addition, your programming can calculate the
total for the order and display it in the parent record .



4th Dimension offers dialog
layouts as well, so that you can
create custom dialog boxes .

Using a subfile is like devoting an entire data file to a
single field on a record . One order may contain a subfile
with a hundred items ; another may contain only one or
two. The subfile itself can expand as necessary .

The great advantage of using subfiles is that you can keep
track of a varying number of subrecords for each record
in the parent file . Each parent record can contain none, a
few, or many separate entries in the subfile . Data storage
space is minimized because only needed space is
allocated.

Input and output
You must design the input and output formats for the
information in your database . 4th Dimension calls these
formats Input layouts and output layouts . A layout is a
way of presenting data . When creating a layout, you
identify which fields to use, arrange them on the screen
or page, and enter additional text for titles, instructions,
or comments .

Layouts are directly connected to files because the files
store the information that comes in and goes out. But a
file simply stores the information in fields in records . A
layout can include all the fields in a file or just a few . A
file can have many layouts, each serving a different
purpose, and a particular layout can combine information
from several files .

Typically, an input layout shows a single record . An
output layout shows multiple records .

Input and output
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A customer address file might have several input layouts,
depending on the kind of information necessary for
different operations . The input layout for a new entry
might look like the one shown in Figure 2-5 .

Y

New Customer Record

Last Name Iii:~hri= ; r_iri

First Nome

Address

City

ZIP Code

Phone

IF'hI11ip

151:151 :: Eiii~~d i_;t

Iri iii

	

tii ;rn

CCI 4-Q417
r

Figure 2-5
An input layout

This is the information necessary to create a new record
in the Customer record file . If the customer's record
needs to be modified (because of a name change or a new
address), a different input layout can be used .

w .

Figure 2 .6
Another input layout

Chapter 2; Designing a Database With 4th Dimension

CUSTOMER CHANGE RECORD

Old Last Name Johnson Last Name (Johnson

Old First Name (Phillip First Name (Phillip

Old Address 5050 Boyd St Address 1225 Tait Ave

Old City IMiddletown City IMiddletown

Old ZIP Code 120204 ZIP Code 120212

Old Phone 1554-9413 Phone 1554-9413



Be sure your "simple listing"
places the fields in the same
order as the file you are
importing .

This input layout affects the same file as the New
Customer Record layout, but different processing
instructions are used : first to display the current
information and then to replace any updated information
when the record is accepted .

You would design a layout used by a data entry operator
to ensure that the fields are selected in the proper order,
that they are well spaced, and that they are easy to read .
For data electronically transferred into a database, your
layout can be a simple listing of fields to accept the
imported data .

Output layouts for these files might use almost exactly
the same information but present it in different ways for
different purposes . For example, one layout for printing a
customer telephone list would look like the one shown
in Figure 2-7 .

Figure 2-7
An output layout

Another layout, for printing the mailing address on the
bill, might look like the one in Figure 2-8 .

Input and output 19

Last Name First Name Phone

Johnson Phillip 554-9413
Arnold Jim 555-4212
Firth Joan 632-1619
Stevens Sally 699-3304
Williams Mary 394-8887
Anderson Charles 344-5657
Wilson Ryan 339-7763
Smith Wanda 334-8099



Figure 2-8
Another output layout
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A layout for the screen display for an order clerk would
present the fields arranged for easy reading and fast
searching . A layout for the screen display for a service
representative might include additional fields for
adjustments, billing status, or action taken .

A manager's report might not contain any raw data but
merely a summary of activity for the period . Even the
particular summary would depend on the particular
manager involved . One executive might receive a report
on the average number of transactions per day, broken
down by day of the week and month . Another might need
to see total income for a period compared with similar
periods from the preceding year .

Phillip Johnson
225 Talk Ave
Middletown CA 20212

Jim

	

Arnold
420 Hudson St
Harley CA 21200

Joan

	

Firth
1 396 First St
Northland CA 21 022

Sally

	

Stevens
14W . Main
Bleaker CA 22142

Mary Williams
4445 Fourth St
Sunnyvale CA 20102



Processing
Each database may have many files related in various
combinations. Each file may have several input and output
layouts . A particular layout may draw information from
different files and send it to different files as well .
Information can be verified, checked, duplicated,
calculated, and moved from one place to another. For some
of these procedures, you will need to write programming
to control the processing of the information .

Processing controls the way information moves from
input to storage and then to output. You can select
portions of , the information, calculate additional
information from the input data, and perform other
application tasks such as sorting or updating other files .

For each input and output layout, you can create
processing that manipulates the information in various
ways to handle the calculation, verification, and error-
checking necessary for the data you are using . For
example, you can establish range checking on the data
entered into a field, or you can verify the date as it is
entered .

An output layout can use processing that calculates
subtotals, totals, cumulative totals, and any of several
other important statistical calculations. This information
can be created while the report is printing, it can be
saved in a particular file for later use, and it can be used
by other files for other purposes at another time .

You use a high-level procedural language to create these
processing instructions, called procedures by 4th
Dimension. Global procedures can start from menu
commands and serve as subroutines . Layout procedures
control input and output processing associated with each
layout.

Processing
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/Design €Y
User 8BU
Custom € I
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4th dimension's environments
4th Dimension works in three distinct environments :
•

	

Design: to create the application
•

	

User: to test procedures, perform specific tasks with
the data, and run noncustomized applications

•

	

Custom: to test the final, complete application as the
end user will see it

4th Dimension helps you create several important parts of
your application : the file structure, the input and output
layouts, and the desktop user interface-Apple's graphics-
oriented system of pull-down menus and windows.
The Design environment is where you create the database
file structure and layouts, write procedures, and create
menus and passwords for customized applications .
You can use 4th Dimension's User environment to enter
and work with your data, producing standard reports and
graphs . If you want to create custom menus and
procedures for your application, you can use the Custom
environment.
You use 4th Dimension's procedural language to program
menu commands and to perform the necessary processing
of the information for the Custom environment .
The Environment menu provides access to the three 4th
Dimension environments .



Design
/Structure
layout . . .

	

l
Procedure . . .

	

€P
Menu . . .

	

M
Passwords

The Design environment
The Design environment contains the five editors
necessary to create a database application. This is a
multiwindow environment, so that you can quickly switch
among the editors :
•

	

Structure: to create files, assign fields and field types,
and create links between files

•

	

Layout: to create input, output, and dialog layouts for
each file

•

	

Procedure: to write procedures to process the
information

•

	

Menu: to create custom menus for your application
•

	

Passwords: to create password security for your
application

The Design environment
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Structure editor menu
commands to create, edit, or
delete files and fields

Filename displayed at top of file

Scroll bars to view adjacent but
hidden files

Show Page box to display entire
file structure
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The Structure editor

You begin designing your database application with the
Structure editor . Use the Structure editor to
•

	

create and name files and subfiles
•

	

create and name fields and subfields
•

	

set field types and attributes
•

	

link files
a edit filenames and field names
•

	

view all files in the database

File Edit Environment Design Structure

Figure 2-9
The Structure editor window



Layout editor menu commands
to control text, line, fill design,
and color

Palette tools

Rulers to assist in placing layout
elements

The Layout editor

You create input and output layouts with the Layout
editor. For each layout, you can
•

	

choose from eight standard layouts or create a custom
layout

•

	

choose which fields to include on the layout : all, some,
or none

•

	

modify elements of the layout
a create Macintosh interface tools, such as check boxes,

scrollable areas, buttons, graph areas, and any variable
you want to include on the layout

•

	

include displays of layouts from other files
•

	

include fields from linked files
•

	

assign display formats for dates, numbers, and variables

dl~dd

r - i
L_J

q~qu
r
r

50

	

1 0

	

150 200

	

250

	

300

	

350 rri

0
i File Edit Environment Design Font Style Layout Colors

Layout : EntryScreenl

Emi 1 ogees
Employee Number

Lost Name

First Name

Deportment Code

Manager

Salary

Title

Start Date

lEmpi0L

(Last Name

(First Name

Depart

Salary

(Start Date

x e

ITitle

Employee Type :

	

Other Information :

•

	

Permanent 0 Stock Plan

•

	

Temporary 0 Savings Plan

Figure 2-10
The Layout editor window

The Design environment
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Procedure editor Search menu
to find or find and replace

Select from complete list of
commands, functions, and
global procedures

The Procedure editor
You use the Procedure editor to write instructions for
processing the information. With the 4th Dimension
Procedure editor, you can
•

	

use either the flow chart or the listing method for
writing procedures

•

	

create global procedures for use as menu commands or
subroutines

a create layout procedures to control processing for a
specific layout, whether input, output, or dialog

•

	

create file procedures for controlling files
•

	

use any of the commands and functions in the 4th
Dimension programming language

Figure 2-11
The Procedure editor window
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File Edit Environment Design Search

Loyout Proc . : EntryScreenl ~_
The before section of the code executes before the layout is put on the screen .

If (Before)
DISABLE BUTTON(xFirst)
If (New=1)

New is set globally in the AddEmpl or ModEmpl procedure .
new keeps track of whether or not this is a new record .

DISABLE BUTTON(xPicture~
DISABLE BUTTON(xReview)
DISABLE BUTTON(xLocation)
BUTTON TEKT(xNext ;"OK and Next")
xDeptname :="Eriter Dept Code . . ."
xManager :="Enter Dept Code . . ."
Employee Number :=EmployeeNo

\Keywords f

	

4 Routines
=

If
Else
End if
Case of

End case
While

Employee Number
Last Name
First Name
Department Code
Salary
Picture
Review Info
Office Location

Q

:

:

ABORT
Abs
ACTIVATE LINK
ADD RECORD
ADD SUBRECORD
ADD TO SET
After
ALERT^Q



Menu editor menu to add or
insert menu titles or items

Enter your own menu titles

Set command key equivalent
for menu item

Enter password protection for
security

The Menu editor

You use the Menu editor to create complete menu bars
and menu command choices for your custom application .
The Menu editor allows you to
•

	

create and modify custom menu titles and items
•

	

specify the global procedure for each menu item
a create several separate menu bars with different menus

on each bar
•

	

preview each menu and menu bar as it will look in the
final application

•

	

install a picture to be used as background for each
menu bar

a protect access to specific menu items by setting a
password

•

	

specify keystroke equivalents for each menu command

Figure 2-12
The Menu editor window

The Design environment
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File Edit Environment Design Menu

	

Employees

# JMenubar 1
Menus Items Procedures

File Q New Employee * Addempl

Departments
Search and Modify . . . Modempl

Employees Modify From List . . . ModEmplFromList
Menus
Utilities Remove Employee Delempl

1:1 Keyboard : N Bold
Line

	

Italic
~i1 Enabled

	

Underline
Outline

Password . Shadow



Passwords editor menu to
create or modify password

Password record shows date of
last use, number of uses for
each password

Passwords on separate "paths"
to maintain separate
authorization

The Passwords editor
You use passwords to control access to menus and
layouts. The Passwords editor allows you to
a create a hierarchical password system
•

	

protect menu bars, menu titles, and menu items
•

	

control access to the Design and User environments
•

	

view and edit the passwords for the entire application

File Edit Environment Design Passwords

User

Last use : 09110186

Number of uses : 3

Billy

Last use : 00/00/00

Number of uses : 0

Manager

Last use : 01/12/87

Number of uses : 148

GeorgeXXY

Last use : 00100100

Number of uses : 0

Figure 2-13
The Passwords editor window
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Budgetl5 .x

Last use : 00100100

Number of uses : 0



The User environment
The User environment contains database functions that
let you enter data without customizing the database, test
your application, perform specific processing functions,
and check the design and placement of layouts and dialog
boxes. You can use any layout for input or output, and
you can execute any global procedure to check whether
processing is correct .

File Edit Environment Enter Select Report Special

Figure 2-14
The User environment menus

The User environment allows you to
•

	

enter and modify data
•

	

view and print data through input and output layouts
•

	

search and sort records
•

	

create standard reports and graphs
•

	

import and export data
a set an ASCII map (a character-translation table)
•

	

execute procedures
•

	

print mailing labels

The User environment 29



Entering and modifying data

You can enter new records, modify existing records, or
use a formula to modify records .

You can
•

	

enter test data
•

	

perform data entry for a database
a use different input layouts to determine which is more

effective and easier to use
•

	

change the current input and output layouts

30
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Searching and sorting records
You can search the database to isolate specific records or
groups of records for display or processing . You can
change the sort order of the database (the order in which
the records are displayed) .

You can
•

	

use search criteria (for example, "Salary is greater
than $15,000") to display a group of records

•

	

search and modify records based on indexed fields
•

	

use a procedure to search
a save search criteria for future use
•

	

enter sort fields by selecting from a list
•

	

use 30 levels of sorting
Figure 2-15 shows sorting on three fields .



Sort order determined by
entering field names

Fields in current file

Sort ascending or descending ;
change by clicking on arrow

File Edit Environment Enter

Employee Number
Last Name
First Name
Department Code
Salary
Employee Type
Stock Plan
Savings Plan
Title
Start Date

Sort Employee S .

Select

Cf rf Ci„nln~~nnr

Report Speciol

Start Date 0
Last Name El

First Name El

Cancel :

	

Sort

1

Figure 2-15
Sorting records

Creating standard reports, graphs, and mailing
labels
You can create three standard reports in the User
environment, in addition to any reports defined by output
layouts and associated programming ;
•

	

quick reports that provide a tabular summary of the
information, including subtotals on breaks and totals

•

	

graphs that summarize the information in the database
•

	

mailing labels that print data using an output layout
designed for mailing labels

The User environment
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Setting an ASCII map

This special feature helps you to import and export files .

You can set an ASCII map to create application-specific

ASCII codes . This allows you to correlate the Macintosh

character set with any character set from any machine and

save it for future use .

Executing procedures

With this special feature, you can execute procedures

to test and debug them before using the Custom

environment .

The Custom environment

The Custom environment allows you to run a customized

application as the end user would see it . Therefore, it is

different for every application you create . In the next

chapter, you will examine one example of an application

created in the Design and User environments and running

in the Custom environment .

The Custom environment

o gives you complete control over menus, layouts, and

processing

a has the standard Apple and Edit menus

a is equivalent to the runtime version of 4th Dimension



Chapter 3

Looking at a Finished
Application
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It's always a good idea to have an idea of where you are
going before you start . For your own applications, you
plan the file structures, the input and output
requirements, and the processing . The example database
included with your program is designed to show several
features that are unique to 4th Dimension, not just to
provide a solution to an application problem . You will
see fields that store pictures, graphs that change instantly
when a value is changed, and features created with the
powerful programming language or brought into the
application from an external routine .

Opening the example database
To see the example application, you must start 4th
Dimension and open the database named Personnel. It is
included on the Examples disk. You should first copy the
Personnel Example folder to your hard disk .
1 . Start 4th Dimension by double-clicking on the 4th

Dimension icon .
If you need instructions for installing 4th Dimension,
see Chapter 1, "Introducing 4th Dimension ."
4th Dimension displays the Welcome screen . The file
list shows all the folders and 4th Dimension
applications on your hard disk .

2 . Select Personnel Example and then click Open .
4th Dimension opens the Personnel Example folder .

3. Because the Personnel database is already selected,
simply click Open again .
4th Dimension opens the Personnel database,
displaying the Enter password dialog box .

4. Type User and then click OK or press Return .
Be sure to type the password exactly as it appears
here, including an uppercase U and no extra spaces .



Custom menus

Standard Apple menus

4th Dimension displays the title screen of the custom
application .

File Edit Departments Employees Menus Utilities

Figure 3-1
A custom title screen

4th Dimension	 ~_

Custom screens, menus, and passwords

The title screen of your application is a picture provided
by the company, drawn by you, or obtained commercially .
4th Dimension allows you to use any image that can be
stored in your Scrapbook or transferred through the
Clipboard to customize the applications you create .
The menus across the top of the screen provide the
commands to run the application. The Apple menu and the
Edit menu are standard Apple menus, but all the others
are specifically created for this application .

Custom screens, menus, and passwords
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Menus
Data Entry

	

D
Management Reports . :#:M

36

	

Chapter 3 ; Looking at a Finished Application

Take a look at the commands on the Menus menu . These
have been placed on the menu by the developer of the
application. They work the way any Macintosh menu
commands do. You will see how to create them in Chapter
10, "Creating Custom Menus ."
1 . Pull down the Menus menu and choose Management

Reports .
4th Dimension displays a dialog box denying you
access to the Management Reports section of the
application .
The developer of a custom application can provide this
kind of password protection for any menu command . To
use this menu, you must restart the application and
enter Manager as the password (again remembering to
use an uppercase M) .

2. Click OK .
4th Dimension returns to the initial screen .



Handling records
Entering, modifying, and removing records for employees
and departments are the basic functions of the personnel
application . The user of this application often needs to
make changes to an employee record . Suppose, for
example, that employee number 5, Nathan Anderson, has
changed jobs within the company, moving to a different
department .

To modify the record, you use the commands beneath the
Employees menu :
1 . Choose Search and Modify from the Employees menu .

4th Dimension displays a custom search dialog box .
Here you can enter either the employee number or the
employee name to display the record you want to
modify .

Modify employee . . .

- Search by . . . -
;i: Number
i Last Name

[:ante

Search

Figure 3-2
A custom search dialog box

Handling records
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Field names

Fields

Custom buttons

38

2 . Type the number 5 then click on Search or press Enter .
4th Dimension displays the employee record for Nathan
Anderson. The record is displayed on a custom input
layout .

j l . lax Edit

	

)3rr €

	

€ J 3E 4

	

fk U4

	

li it i es

4th Dimension	

Empl ogees

Employee Number

Lest Name

First Name
Deportment Code

Manager
Salary

Title

Start Date

- Employee Type :
® Permanent
0Temporary

Flgure 3-3
A custom Input layout
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Art Ier_,on

1Nathan
ACCP

	

Accounts Payable

Mrs . Adams
$39,500

1Monager2

102!06186

-Other Information :
® Stock Plan

Savings Plan

is~Y€uYr€ i n{)

Review

Office Location

Picture

OK

OK and Search))

I Cancel

You can design the way each record is displayed on the
screen. You have complete control over the placement
of fields, how the background appears, and any
additional text you wish to use .
You can use standard Macintosh features such as
buttons and check boxes . In this example, the
Employee Type field gets its information from one of
two buttons. Two other fields, Stock Plan and Savings
Plan, get information from check boxes .



Mr. Anderson's job title has changed because he has
been promoted, so you need to change the entry in the
Title field .

3 . Click on the Title field (it's to the right of the field
name and currently contains Manager 2) .
4th Dimension displays a Choices List .

Choices for Title

Engineer 1
Engineer 2
Manager 1
Manager 2
Manager 3
Mktg Coordinator
Plant Coordinator
President
Sales Supervisor
Supervisor 1
Supervisor 2
Vice-President

Cancel

	

Modify

Figure 3-4
A Choices list

4. Click on Manager 3 in the Choices List .
4th Dimension enters your choice into the field .
Choices Lists are a good way to ensure accuracy and
save data entry time when a limited number of valid
entries can be used in a field .
Mr. Anderson has been moved to the Accounts
Receivable department, so you need to change the
Department Code field .

Handling records
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5 . Click once on the Department Code field .
This field is linked to the same field in the
Departments file. The department name and manager
name stored in that file are brought into this record as
soon as you enter the correct department code .
Unfortunately, you don't know the code .

6. Type @ (the at symbol) and press Return .
4th Dimension displays a selection list showing the
department code and name for each department .
The @ sign is the "wildcard" symbol throughout 4th
Dimension. When entered in the linking field, it forces
the display of the link selection list . You can use it in
other contexts for different purposes .

7 . Move the pointer to ACCR (the code for Accounts
Receivable) in the selection list .
This link selection list works like the Choices List for
titles. But because the information is in a linked file,
more than one piece of information can appear on the
employee record .

8. Watch the Department and Manager fields as you click
on ACCR.
The correct department and manager names are entered
when the new department code is entered .

Special features
You have one more chore to perform for Mr . Anderson's
record, and it is a pleasant one. His most recent
performance review was an excellent one, and you need
to update his review file .



A Multi-line layout shows as
many records as there is room
for in the display area, A Full
Page layout shows one record at
a time .

Graph of performance rating
scores

As you do so, you will use a second data entry screen for
Mr. Anderson's record, enter a subrecord into a subfile,
watch the result graphed, and change the graph type .
1 . Click the Review button .

It's one of the custom buttons on the right side of the
screen .
4th Dimension displays the second data entry layout . In
this database there are four such layouts, each showing
a portion of the information . This layout includes a
subfile that contains all of Mr . Anderson's performance
reviews .

2 . Use the scroll bar to move past the previous reviews .
You want to show a blank subrecord in the Review
Info area. This is a Multi-line layout (see Figure 3-5) .
You are going to bring up a Full Page layout to enter
the new review (see Figure 3-6) .

[mpl a!jee - Nathon Anderson
Review nfa :

Date
12/20186

Comments
Solved several nagging problems as a
new system was implemented . Nathan

4th Dimension

3/86

	

6/86

	

9186

	

12/86

C
Line graph

	

® Bar graph

Rating
5 .0

® Rating

General Info

Office Location

Picture

OK

(OK and Search

Cancel

Ifs

	

Edit

	

I g>I~€

	

€

	

}€its

	

I :

	

iF

	

f~fk~

	

Fk

	

s

	

i1 li1

Figure 3-5
Scrolling the subrecords

Special features
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Date field

Text field

Real number field

3 . Double-click on the blank subrecord .
4th Dimension displays a blank subrecord from the
subfile. Each employee record contains as many
subrecords of review information as necessary .

l ilFk

	

Edit

	

{ 1

	

es

4th Dimension

Enter

f
Delete

f

i Cencel

Figure 3-6
A Full Page layout

4 . Type 3116187 and press Tab .
The tab key is recommended for moving from one field
to the next. Shift-Tab moves to the previous field . Of
course, you can use the mouse to select the field you
want to work with .
The insertion point moves to the Comments area . This
is a Text field that can contain up to 32,767 characters .

5 . Type Great work! and then select the Rating field .

Employee :

Review Date

Comments

Rating :

42
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Nathan Anderson

oa



6. Type 5 .0 and click Enter .
4th Dimension accepts the record, returns the display
to the data entry layout, and updates the graph with the
new rating score .

7 . You prefer line graphs, so click the Line graph button
to change the display .

Empl o ee -

C

2-

Figure 3-7
A line graph

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3186 6186 9186 12186 3/87

Line graph	0Bar graph

0 Rating

8. Click OK to accept the modified record .

Further information
Feel free to examine the Personnel database on your
own. You might be particularly interested in the
following aspects of this application .
∎ Access to linked files: Select the Department Code

field again and enter a new department code, for
example, XXX. 4th Dimension displays a dialog box

Further information 43

Date Comments Rating 1
03116186 Nathan has contributed greatly in his 4 .8

first quarter an board .

06!15186 Nathan ,met or surpassed all his 4 .9
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asking if you want to create a new record in the
Departments file . If you choose to do so, a blank record
is displayed for you to enter the information .

•

	

Range checking: Select the Salary field and try to enter
a salary of $150,000 (don't use the dollar sign or the
comma) . 4th Dimension displays a dialog box telling
you the largest value it will accept for that field .

•

	

Picture fields : Click the Picture button in Nathan
Anderson's record. The data entry layout that is
displayed shows his picture. The picture has been
entered by digitizing a photograph and then copying it
into the field from the Scrapbook . Now click on Office
Location to see a map with a movable marker .

∎ Calculator: Choose Calculator from the Utilities menu .
4th Dimension displays a useful calculator that has
been programmed entirely with 4th Dimension's high-
level structured procedural language .

•

	

Customized reports : Open the example application
again using the Manager password . You can now see
the management reports that have been custom-
designed for this application .

•

	

Database design: With the Manager password, you have
access to all three 4th Dimension environments for this
application (choose Quit from the File menu to leave
the Custom environment) . Examine the data structure,
the layouts, the layout procedures, and the password
structure to obtain a deeper understanding of how 4th
Dimension works .

Two text documents, Read Me and Command Index, are
included in the Personnel Example folder . They provide
an introduction and guide to all of the 4th Dimension
features illustrated in this application .
Now that you have seen a fairly substantial application,
you can start at the beginning . The following chapters
guide you step by step through the creation of a similar,
but simpler, personnel database .



Chapter 4
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Setting up a new database begins with exhaustive

planning before you use 4th Dimension . For this example,

suppose that you have already analyzed the information

needs of the personnel department and planned the file

structure for your database . You plan to use one file for

employee information and another file (linked to the

first) for department information. In addition, you plan to

use a subfile of the employee file for each employee's

performance review scores and statements .

The reasons for using these elements are discussed in

later chapters. In this chapter, you will see how one file

is established-from first appearance to final layout . Here

you will learn how to use the tools that create fields,

layouts, and display formats . These tools apply to any file

you use in a 4th Dimension database .

Creating new files

You need to create database files to hold the information .

4th Dimension automatically creates your first file for

you. Your job is simply to rename the file so that it

reflects the database you are setting up . In this section,

you'll rename the first file for employee information, and

then you'll create a second file for information about

departments .

1 . Start 4th Dimension. When the Welcome screen is

displayed, click New.

4th Dimension displays the new database name screen .

Here you enter the name you want to use for this

database .

2. Type New Personnel .

This is the name 4th Dimension will use to save your

database. You can use any valid Macintosh filename (up

to 15 characters) .

3. Click Save .



4th Dimension creates several necessary files, placing
them in a folder named New Personnelf .. The italic f at
the end of the folder name is added automatically to
show that it is a 4th Dimension folder .
4th Dimension displays the Structure window . It
contains a single empty file, named Filet .

Structure far NEW PERSONNEL	p=

3

40

Figure 4-1
The first file is created automatically

As you remember from Chapter 2, the Structure
window shows the file structure of the database . At
present, the Structure window shows only one file,
automatically created by 4th Dimension . Additional files
you create will appear in this window as well .

4. Choose Rename file from the Structure menu .
4th Dimension displays the Rename file dialog box .

5 . Type Employees and click OK .
The Structure window shows the renamed file. The
width of the file itself has increased to accommodate
the new name .
You now need to create a second file, which you will
later link to the first file .

6. Choose New File from the Structure menu .

Creating new files
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The pointer changes to a square file icon (the same
shape that 4th Dimension uses to display a file) . It
remains file-shaped until the next step .

7 . Position the pointer where you want the new file to
be located, and click .
Filet is created at that location .

	:• 4th Dimension tip. Once you have created a file, you can move
it to any location in the Structure window . If you change your
mind about creating a file after you have chosen New File from
the Structure menu, move the file-shaped pointer into the menu
bar and click. This cancels the command, and the pointer
again becomes an arrow .

8. Rename this file Departments .
You renamed Filet in steps 4 and 5 above ; use the same
method to rename Filet .

EMPLOYEES

ar

Structure for NEW PERSONNEL
4

Figure 4-2
Two renamed flies

You now have two files: the first is automatic; the
second you created with the New File menu command .
You can create up to 99 files for a single database . In a
later chapter, you will learn about linking one file to
another .



Important Subflles are very different and are created in a different way.
You cannot convert either of the flies Just created into subfiles
later on. Subfiles are discussed in Chapter 7, "Using Subfiles,"

Creating fields
Within each file, you now need to create the fields that
identify the kinds of information you want to store . For
the Employees file, you want to keep track of the Last
Name, First Name, Start Date, Salary, and Title . Each of
these pieces of information will be a separate field .
Each field in a 4th Dimension file has a field type that
identifies the kind of data to be stored in that field . In
addition, each field can have one or more field attributes
that determine other aspects of the field's use .
1 . Click once anywhere on the Employees file to

select it .
The filename is highlighted to show that it is the
current file .
If you accidentally double-click on the filename, 4th
Dimension displays the Layout dialog box . To return
to the Structure window, simply click on Done . If you
accidentally double-click on the empty part of the
file, step 2 is not necessary .

2 . Choose New Field from the Structure menu .
4th Dimension displays the Add or . Change Field
dialog box. You use this dialog box to name the field,
set the field type, and establish all the attributes for
a field .

Creating fields
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Add or Change Field in EMPLOYEES

Field name :

( Subfile

Field l

Figure 4-3

The Add or Change Field dialog box

3 .

Chapter 4 ; Creating a New Database

The field name cell is highlighted, so enter your first

field name simply by typing Last Name .

4th Dimension replaces Fieldl with the new field

name.

4 . Leave the field type set to Alpha and the length set at

20 .

This is the Alphanumeric field type, used for fields

that contain a short amount of text (up to 80

characters) .

5 . Click the check boxes to make this field Mandatory

and Indexed .

Making this field mandatory causes 4th Dimension to

check whether a record has an entry in this field

before it is accepted. Indexed means that 4th

Dimension creates an index file to keep track of each

entry in this field, making searching and sorting

faster .

6 . Click OK and Next .

4th Dimension displays a new Add or Change Field

dialog box for you to enter the field name, type, and

any attributes for the next field .

7. Enter First Name, leave the field type Alpha and length

20, and also make this field Mandatory and Indexed .

® Alpha 20 El Mandatory I OK and Nent

OTent

	

El Display only

o Real

	

El Can't modify

O Integer

	

O lndened

O Long Integer Cance

Date

	

0 Standard

0 Picture

Choices
OK



Field type symbols

8 . Click OK and Next .
4th Dimension displays a third Add or Change Field
dialog box .

9 . This time enter Start Date, and make it a Date field
type. Then click OK and Next .
Date fields are, of course, for dates . 4th Dimension
can display dates in several ways and perform date
arithmetic . You set the display format in another
place; the steps are presented later in this chapter .

10. For your fourth field, enter Salary, and make it a Real
field type .
Real is short for "real numbers ." Real fields are for
real numbers, which can include decimals .

11 . This time, click OK .
4th Dimension displays the Structure window again .
The Employees file shows the field names you have
entered, together with the field type symbols . Notice
that the fields you want indexed are displayed in
bold.

Last Name A
First Name A

:3al .~r-u

Structure far NEW PERSONNEL	P_

DEPARTMENTS

RT F ::::J lIIIIIIIIII

Figure 4-4
Field names and types displayed in the Structure window

Creating fields
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Further information about field types

The first seven field types enable you to create field
types for words, numbers, dates, and pictures . The eighth
field type actually creates a new file-a subfile-in
which you enter field names, types, and attributes . Here
is a short description of each field type . For complete
information about field types, see the 4th Dimension
User's Guide and the 4th Dimension Programmer's
Reference .
•

	

Alpha fields contain alphanumeric data between 2 and
80 characters in length . Typically, you use this type for
names, addresses, zip codes, and telephone numbers . An
Alpha field can be indexed for fast searches and
sorting .

•

	

Text fields also contain alphanumeric data, but you can
enter up to 32,767 characters . This type of field is
useful for comments, documents, and notes . A Text field
can be searched, but not indexed .

•

	

Real fields contain real numbers, which can include
decimal points. The Salary field is a Real field type, as
would be any field that uses decimals .

•

	

Integer fields contain integers between 32,767 and
-32,767 . An integer is a whole number; it cannot
contain a decimal point. A Record Number or Employee
Number field would be a good candidate for the
Integer field type .

∎ Long Integer fields contain integers between
2,147,483,647 and -2,147,483,647 .

∎ Date fields contain dates .
∎ Picture fields contain Macintosh pictures. Picture

fields are useful for photographs, maps, and diagrams .
•

	

Subfile fields contain an entire subfile . The subfile is
created when a field is made type subfile . For further
information, see Chapter 7, "Using Subfiles ."



Further information about field attributes

Field attributes make it possible for you to add further
instructions for conditions or features to each field .
Attributes affect how the field acts during data entry or
how you access the field. Here is a short description of
each attribute . For complete information about field
attributes, see the 4th Dimension User's Guide and the
4th Dimension Programmer's Reference .
•

	

Mandatory means that the field must contain an entry
before 4th Dimension accepts the record .

•

	

Display only makes it impossible for the user to enter
a value into the field. This attribute is typically used
for calculated values .

∎ Can't modify makes the field entry on each record
permanent once the record is accepted for the first
time .

•

	

Indexed creates an index file of all entries in the
field, arranged in order . This makes searching and
sorting much faster than if the field were not indexed .

•

	

Unique prevents records from containing duplicate
entries in the field .

∎ Standard Choices allows you to create a Choices List of
valid entries for any field (except picture and subfile
fields). The user can then select the correct entry from
the list .

Creating fields
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Creating a Standard Choices list
Your company maintains a strict set of official job titles .
This means that there are a limited number of possible
entries for the Title field . You have decided to simplify
the data entry process for this field by setting up a
standard list of choices . You do this with the Standard
Choices attribute .
The instructions for this section begin where the tutorial
left off above .
1 . Double-click on a blank area within the Employees file

icon .
Double-clicking is equivalent to choosing New Field
from the Structure menu . If you double-click with the
pointer on a field name, 4th Dimension displays the
same dialog box, showing the specifications for the
selected field .
If you accidentally open the dialog box for another
field, simply click Cancel and perform step 1 again .

2. Enter Title as the field name, and click the Standard
Choices attribute check box .
The Choices List button becomes active .

3 . Click the Choices List button .
4th Dimension displays the Standard Choices dialog
box .

4. Type in the following choices you are making available
to the user . After each title, press Return or click on
Append .



Manager 1
Manager 2
Manager 3
Supervisor 1
Supervisor 2
Engineer 1
Engineer 2

+ 4th Dimension tip: Don't click on Append after the last entry,
or you'll enter a blank line .

5 . So that this list of choices can be changed by the user
during data entry, click the Choices can be modified
check box .
From time to time, a new job title is added or one is
dropped. Making the list of choices modifiable allows
the user to change it "on the fly ."

6. You notice that the list is not in alphabetical order, so
click on Sort.
4th Dimension sorts the list of choices, displaying the
choices in alphabetical order .

Standard choices for Title

Engineer 2
Manager 1
Manager 2
Manager 3
Supervisor 1
Supervisor 2

Engineer 1

® Choices can be modified

LSort

Insert

Append

Delete

Cancel

OK

Figure 4-5
The sorted Choices List

Creating a Standard Choices List 55
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7 . Click OK .

4th Dimension returns to the Add or Change Field
dialog box . The Choices List is saved with the other
database files .

8. Click OK to return to the Structure window .

Creating a layout
Once you have created a file with the field names you
are going to use, you then create a layout . In fact, you
usually create at least two layouts, one for input and one
for output. Here are several important points about 4th
Dimension layouts :
a The layout displays the fields for future data entry and

display. The layouts enable the user to enter data into
the fields and to display data from the fields .

a You can make several layouts for each file, arranging
the fields differently for different purposes : one layout
for data entry and another for reporting, for example .

o You set the display format for numeric, date, and
picture fields for each layout .

D You can create variables that appear on that layout .
a You can create programming that performs processing

for the information on that layout .

In this section, you will create a basic input layout for
the Employees file of your database .
1 . If necessary, click once on the Employee file to make

it the current file .
2. Choose Layout from the Design menu .

4th Dimension displays the Layout dialog box-the
gateway to all the layouts you create for this database .



I.. dyout . . .

EMPLOYEES
DEPARTMENTS

Enpand

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

New

1
Done

Nome :

Password :

Figure 4-6
The Layout dialog box

The Layout dialog box now shows the filenames . When
you create other files, they are displayed here . After
you have created layouts, the layout names are
displayed below the filenames. The other functions of
this dialog box are explained later in this chapter .

3 . Type Data Entry into the Name field .
This is the layout name . Since the Name box is selected
when the Layout dialog box opens, you can type the
layout name immediately .

4. Click New .
4th Dimension displays the New layout dialog box .

Creating a layout
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Data Entry

Figure 4-1
The New layout dialog box
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On the left side of this dialog box, you can select
specific fields to display on this layout . 4th Dimension
by default uses all the fields . You want to use all the
fields, so you do not select any of them .
On the right side, you can change the font size, choose
a standard layout pattern or a custom layout, or change
the layout name .
You decide to use the layout pattern already selected
on the left of the middle row . You want to use all the
fields, the 12 point font size, and the layout name you
entered in the previous dialog box . So this dialog box
is completed .



5 . Click OK .
4th Dimension creates the layout you have specified
and displays it in the Layout window named Layout:
Data Entry, the name you entered in the Layout dialog
box .

Figure 4-8
The Layout window

With this step, you have completed the minimum
requirements for your file . If you are content with the
standard layout and the default display formats, you can
simply close this window (which automatically saves
the layout) and continue with additional chores (adding
additional files, entering data, or writing procedures) .
Typically, however, you will modify your standard
layout, set display formats, and create a second layout
for data output to the screen or printer. The remainder
of this chapter takes you through this process .

Creating a layout
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Modifying the layout
The standard layouts provided by 4th Dimension are
sufficient for most of your needs . You can modify any
layout so that it fits your exact needs . In this section,
you'll change the title of the layout so that it is more
descriptive of its function .

The layout has been given a title that is the same as the
filename, Employees . Since this particular layout will be
used to enter and modify information for each employee,
you decide to change the title to Employee Information .

You modify the elements on the layout as you would the
elements in a Macintosh drawing program, such as
MacDrawTM. Each element is an object that you select in
order to change it . You can move the object simply by
selecting it and dragging it to its new location. You use
the "handles" that appear on the boundary of an object (an
invisible rectangle enclosing the object) to change the
size of the object.
1 . Click the zoom box so that the Layout : Data Entry

window fills the whole screen .



Zoom box

Layout menus

Palette tools

_L1	Layout : Data Entry	

0
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i File Edit Environment Design Font Style Layout Colors

0 r-~
L J

0

q~plp
b
b

EMPLOYEES

Lost Name

First Nome

Start Dote
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Figure 4-9
An expanded Layout window

2 . Click once on the title Employees .
4th Dimension displays the handles around the title .

:EMPLOYEES k:

`50

-100

-150

`200
as

F

'250

Figure 4-10
The "handles" around a selected element

The title area is an object, as is each element on the
layout. When it is selected, handles appear on each
corner of the boundary. In step 4 below, you'll use one
of the handles to resize the title area .
If you like, select different objects in the layout area .
You will see that the handles always show the selected
object. Be sure to select the title again before going on
to the next step .

3. Drag the title area to the left, placing it just within the
border of the layout .

Modifying the layout
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Figure 4-11
Dragging a selected element

You drag an object, of course, by putting the pointer
on it, pressing the button on the mouse, and holding it
down while you move the object to its new location .
When you start to move the title area, it becomes a
blank rectangle .

4. Resize the title area by making it as wide as the
border of the layout .

EMPLOYEES

Figure 4-12
Resizing an object

You resize an object by placing the tip of the pointer
on one of the handles (so that it changes into a pointer
made of four arrows) and then dragging the handle .
Feel free to resize several of the objects on the
screen. You can always return to the original layout
by choosing Revert to Saved from the File menu or
by choosing Undo from the Edit menu . Be sure to
leave your screen looking like the illustration in
Figure 4-12 before continuing .

5 . Select the Text Area tool from the pallette .
6. Drag the I-beam pointer across the entire title .

EMPLOYEES :I:_

Figure 4-13
Dragging the I-beam pointer



A textual element is a title, an
Instruction, or any other text
entered onto the layout . Do not
confuse such an element with a
field of type Text .

You are going to replace the title with Employee
Information .

6. Type Employee Information .

The new title replaces the old .
	.• Note: The layout title has nothing to do with the layout name;

the title is strictly a textual element added to the layout . When
you refer to this layout in programming, you will use Data
Entry, the name you gave this particular layout .

7. Choose Center from the Style menu to center the
new title .

Your final screen looks like this :

Figure 4-14
An improved layout

You have completed the changes you want to make in
the layout. You now plan to set display formats for the
data in two of the fields . These operations are
described in the next major section .

Modifying the layout
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Drawing

Include File

Create Variable

Alignment

Duplicate

Further information about the layout editor
The Layout editor provides a selection of tools activated
by icons (see Figure 4-15) . Here is a quick overview of
the layout tools and menus available :

LI
O
O

Y

r -~
L-J

''''I'll
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Figure 4-15
The icons for the palette tools

Select

Text Area

Add Held

Grid

Move to Back

∎ Select icon makes it possible to select and drag any
object .

•

	

Text Area icon allows you to create an area for text
and to enter and edit the text you want .

•

	

Drawing icons make it possible to draw lines, circles,
ovals, squares, and rectangles .

•

	

Include File icon allows you to create an area to
display the output layout of another file, usually a
subfile .

•

	

Add Field icon allows you to create an area to display a
field .

∎ Create Variable icon allows you to create an area to
display a layout variable such as a button or graph .

∎ Grid icon turns on an invisible grid that you can use to
align objects precisely .



• Alignment icons align any group of selected objects to
the left, right, top, bottom, center vertically, or center
horizontally .

∎ Duplicate icon creates an exact duplicate of the
selected object .

∎ Move to Back icon puts the selected object or objects
behind all the other objects . Using this tool can cause
an object to seemingly disappear . To get it back, select
the object in front of it and send that object to the
back .

∎ Font menu provides a list of fonts from your system
font file that can be applied to any text element .

•

	

Style menu allows you to change the type style,
alignment, or size of any textual element .

•

	

Layout menu allows you to set line widths, change the
fill and border patterns, perform some of the same
functions the icons provide, and change the units with
which the grid and ruler operate .

∎ Color menu allows you to set colors for layout
elements if you are using a color display .

Entering display formats
Suppose you discover that the person who will enter
most of the information into the personnel database
prefers dates that have the month spelled out . For
example, March 16, 1986. You decide to accommodate this
preference in the Start Date field . In addition, you want
to set the Salary field to show dollar signs and commas .
You set the display format for date and numeric fields on
each layout .

Entering display formats

	

65



Fields

Format choices

66

	

Chapter 4 : Creating a New Database

+ Note: The display format does not affect the way data is
entered into a field. See Chapter 5, "Entering, Data, Searching
and Sorting Records," for entry format information .

To change the display formats :
1 . In the Layout: Data Entry window, select the Start

Date field .
The field is the box with the field name in it . The
field name displayed to its left is a text element in
the layout .

2 . Choose Format from the Layout menu .
4th Dimension displays the Format of field dialog
box .

Format of field . . . Format :

Abbreviated

Short
Abbrew i.ated
Long

Cancel

Figure 4-16
The Format of field dialog box

c

The fields in the file are displayed in the scrollable
list on the left. The Start Date field is highlighted .
The display formats are shown in the box on the
right. You set the format by choosing one of them .

Last Nsrrie

	

A
First N .arne

	

A
Start Date

	

[:
SalarI4

	

P
Title

	

A
-



3 . Select the Abbreviated choice to set that format for
the Start Date field .
This choice would display January 1, 1990 as Mon, Jan
1, 1990 .

:• Note. The three choices presented here are the only date
display formats available .

4. Click OK.
4th Dimension displays the layout again . Although
there is no indication on the layout itself, 4th
Dimension has accepted your instruction for
displaying the Start Date . From now on, when you use
this particular layout, dates are displayed in the
format you have chosen .
You can now proceed to set the display format for
salaries .

5 . Double-click on the Salary field .
Double-clicking is a shortcut to display the Format of
field dialog box .
4th Dimension displays the Format of field dialog box
again, but this time there are quite a few choices for
the format .
You can set the display format by selecting it from
the choices shown, by selecting and modifying it, or
by entering the format character by character .
The display format structure has three parts that
correspond to positive numbers, negative numbers,
and zero . The parts are separated by semicolons .
Using number signs, commas, hyphens, parentheses,
spaces, zeros, and letters, you can create specific
display formats to meet any need . For complete
information, see "Setting Field Display Formats" in
the 4th Dimension User's Guide.

Entering display formats
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Since salaries are always positive values, you do not
need a format for negative values or zero . So, in this
case, you will omit the second and third parts of the
format definition. The next step illustrates the select-
then-modify method of entering a format .

6 . Select the first choice that has a dollar sign .
4th Dimension enters this format in the box above
the list of choices .

7 . Drag the pointer across everything after the
semicolon. This selects the portion of the format
definition that defines negative numbers .

8 . Press Backspace .
The selected characters are deleted .
You anticipate that one or more salaries in this
company will be $100,000 or more, so you need to
insert an additional number symbol between the
dollar sign and the comma .
If you omit this modification, 4th Dimension displays
a series of less-than symbols (<), instead of the
six-digit number, to indicate that the number is too
large to display. Note, however, that the data itself is
not affected by the display. The field would contain
the value, even though the display would not show it .

9 . Click on a spot between the dollar sign and the
comma.
You can see the insertion pointer blinking .

10. Type # .
This enters a number symbol into the format
definition . The display format can now accommodate
six-figure salaries .



Format of field . . . Format :
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Cancel K OK

Figure 4-11
A modified display format

11, Click OK .

4th Dimension again displays the layout . As was the
case with the Start Date field, the display format for
the Salary field has been established .

You have now completed one layout for the Employees
file . In the next section, you will see how 4th Dimension
distinguishes between input layouts (for data entry) and
output layouts (for reports and screen displays) .

Setting input and output layouts
The layout you have created is an input layout : it is
intended specifically for entering data, and it shows one
complete record. You should define at least one more
layout-one suitable for displaying a list of records on
the screen or for use in printing . This kind of layout is
called an output layout .

Until you create another layout, 4th Dimension uses your
first layout for both input and output.

Setting input and output layouts
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In this section, you will learn how to create a second
layout and set the input and output layouts .
1 . Choose Layout from the Design menu .

4th Dimension displays the Layout dialog box . The
Employees filename is highlighted .

2. Click Expand to display a list of layouts for the
Employees file .
The list shows the file you just created called Data
Entry. As you add more layouts, the layout names are
added to this list. If you need to edit a layout later on,
you can select it from this list and then click Open .

3. Select the Data Entry layout name from the list and
then click the Input check box .
4th Dimension displays the selected layout in the box
on the right. This makes it easy to double-check
whether a particular layout is the one you want to
work on .

Layout . . .

EMPLOYEES 4
DEPARTMENTS

Input
Output

Delete
r

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

r

Done
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Name :

Password :

Emplajee I nrornatloe

A

T NM

Irn

P°1 I

Data Entry

I

Figure 4-18
Clicking the Input check box



3. Now you want to create another layout for the
Employees file. Select the Employees filename and then
click New .
4th Dimension displays the New layout dialog box .

4. Type Data Output to name this layout, select the layout
pattern in the upper left corner of the standard layout
patterns, and choose the 9 point Font size .

i File Edit Environment Design Font Style Layout Colors

Figure 4-19
Choosing an output layout

5 . Click OK .

4th Dimension displays your second layout . As you can
see, the original layout, called Data Entry, remains
available in its own window. This makes it possible for
you to switch back and forth from one layout to
another quickly. You can have as many layout windows
open as you want .

Setting input and output layouts
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Figure 4-20
A standard output layout

In Chapter 12, you will see how to set up an output
layout to use in a custom report. At that time, several
important features of output layouts will be discussed .
For now, you need to establish layouts as either input
or output layouts . So go on to the next step .

6 . Choose Layout from the Design menu .
4th Dimension displays the Layout dialog box . Again,
the Employees filename is already highlighted .

7 . Click Expand to display the two layouts you've created .
8. Select Data Output, then click the Output check box .

4th Dimension displays an O (for Output) across from
the Data Output layout name .

9. You have finished working with these layouts for now,
so click Done .
Feel free to change the input and output designations
as often as you like . You will note that 4th Dimension
displays a B (for Both) when you click both check
boxes for one layout .
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•:• Special notes: 4th Dimension does not allow you to delete
the last remaining layout for a file or any layout marked Input,
Output, or Both. You can change the input and output
designation of layouts at any time, either in the Design
environment or in the User environment. There can be only
one input layout and one output layout for any file at any one
time.
If you do not designate which of two layouts should be used for
input and output, 4th Dimension chooses which to use for each
operation, based on a typical single-record layout for input and
a multire cord layout for output.

Summary
This chapter has presented the steps necessary to create a
file in 4th Dimension. You follow these steps for every
file in your database .

Here is a list of the steps presented in this chapter :
1 . Create a file .
2 . Rename it .
3 . Enter field names .
4. Set field types .
5 . Set field attributes .
6. Create an input layout.
7. Modify the layout using the Layout editor .
8. Set display formats for date and numeric fields .
9. Create an output layout .

10 . Designate which layout to use for input and which
for output .

In the next chapter, you will learn how these layouts
function in the User environment for data entry and
display.
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You have finished creating the Employees file in your

database. Now you want to enter data into records so that

you can begin to see how your design works with real

information .

Once you have created a file in the Design environment,

you can change to the User environment to use that file .

You can enter data, for example, to confirm that your

input and output layouts work as they are designed to

and that the display formats are correct . In addition, you

can use the User environment to access your application,

to search and sort records, and to create simple reports

with 4th Dimension's Quick Report feature .

If you are continuing directly from the previous chapter,

you can begin immediately with the next section . If you

are starting here from scratch, start 4th Dimension and

open the example database named New Personnel 1 . You

copied this from the Examples disk . New Personnel 1 is

a copy of the database you created in the previous

chapter .

Entering data

You are going to enter a few dummy records so that you

can see how your application works using typical data .

The first thing you must do is get to the User

environment .

1 . Choose User from the Environment menu.

4th Dimension displays the "No Records for

EMPLOYEES" message . This simply informs you why

no records are displayed . Once a record is entered, 4th

Dimension displays it in the output layout you specify .

2 . Choose New Record from the Enter Menu .

4th Dimension displays the input layout you designed

in the Design environment .
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Control panel

Formats displayed for numbers
and dates

The width of the control panel is
exactly the same as the palette
in the Layout editor window.
This makes it easy for you to
judge how your layout will look
with the panel in place .

Enter

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3

Ca ncel

Edit j. :

Last Name

First Name

Start Date

Salary

Title

Figure 5-1
Seeing the layout in the User environment

Entry for EMPLOYEES	

Empioyee Information

As you can see, this data input screen includes several
buttons and a search icon that 4th Dimension
automatically adds to the layout . This is called the
control panel. If you add your own Macintosh buttons
to the layout, the control panel disappears from the
layout. For further information about buttons, see
Chapter 8, "Using Layout Variables ."
The Last Name field already contains the blinking
insertion point, ready for you to type in the data .
Type Davis and press Tab (or Return) or select the Last
Name field with the pointer .
4th Dimension accepts the entry and moves the
insertion point to the First Name field .
Although you can press Return or select another field
with the pointer, most experienced database users
prefer pressing the Tab key to move to the next field .
The Tab key always works in this way ; Return does not
move to the next field if you are working in a Text
field. Shift-Tab moves you to the previous field .

Entering data
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4. Type Tom and press Tab .
	:• Note: From now on, this kind of instruction will be given simply

as "Enter Tom ." Remember that to enter something into a field
means to type it and then press Tab (or Return) or click with the
mouse .

5 . In the Start Date field, enter 1/16/87 .
This is the date entry format (mm/dd/yy) . You can also
enter the date with hyphens, commas, or periods
between the numbers (mm-dd-yy, for example) . Every
date must be entered in this format, no matter how the
result is to be displayed .
4th Dimension accepts the entry and moves the
insertion point to the next field . The date display has
actually changed to Fri, Jan 16, 1987 (the display format
you set for this field), but unfortunately, the field is
too small to contain the entire date display . You must
change the width of this field when you return to the
Design environment.

6. For Tom Davis's salary, enter 28500 .
This is the number entry format. Do not enter dollar
signs or commas . You can use a decimal point (or a
decimal comma) in a Real-type numeric field and a
minus sign to stand for negative numbers . The program
displays the number using the display format you
have set.
4th Dimension accepts the entry, changes the display to
$28,500 .00, and moves the insertion point to the Title
field.
4th Dimension then automatically displays the choices
list for this field that you created in the Design
environment .
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To stop entering data, you must
follow the sequence shown
here. You must display a blank
record and then click Cancel,

7 . Click on Supervisor 1 .
4th Dimension enters the job title in the Title field .

Figure 5-2
A completed record

8. Click Enter .
4th Dimension accepts the record and displays a blank
record. If you had another record to enter, you would
repeat these steps (3 through 8) .

9. For now, click Cancel .
4th Dimension displays your first record using the
output layout you designed .
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i File Edit Environment Enter Select Report Special

Last Name

EMPLOYEES : 1 of 1	 P1
First Name Start Date Salary Title 4

Davis Tom 01 /16/87

Figure 5-3
A displayed record in the output layout

Notice that the Start Date and Salary fields use the
default display formats because you didn't set different
formats on the output layout .

You have accomplished several important things in these
few steps . You have
a entered one record into your New Personnel database
o seen how your input and output layouts work in

practice
a confirmed that the display formats are correct
o discovered an error in the input layout (the Start Date

field is too small to display the entire date) that you
can correct later

28500 Supervisor 1

Notes on entering data
You have seen how to add records to the database in
the User environment . To add records from the Custom
environment, you must create a procedure started by a
menu command . For information on doing so, see Chapters
9 and 10, "Using Global Procedures" and "Creating
Custom Menus ."

Whichever environment you use, once the records exist,
they can be accessed from either environment .

80

	

Chapter 5; Entering Data, Searching, and Sorting Records



Notes on deleting data
To delete a record, select the record from the display
layout and choose Clear from the Edit menu . You can
delete several records at once by selecting them all first
and then choosing Clear from the Edit menu . You can
write a procedure to delete records from either the User
or the Custom environment .

You can delete any field entry simply by selecting the
field and pressing Backspace.

Opening another database
The next two sections of this chapter show you how to
manipulate groups of records . So that you won't have to
enter all these records yourself, you can use the sample
database, New Personnel 2, on the Examples disk .
1 . Choose Open Database from the File menu .

4th Dimension displays the files you copied from the
Examples disk .

2. Click New Personnel 2 and then click Open .
4th Dimension displays a list of employees . This
database has been set to Open in the User environment .
For information about setting preferences, see 4th
Dimension User's Guide .

There are 23 records entered in this database, enough to
demonstrate a few of the basic features of the User
environment. These are the sample records that you will
sort and search .

Sorting the records
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Select
Show All
S £ } S€ 35£x

Search . . .
Search and Modify . . .
Search by Formula . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Sort . . .

Sorting the records
The order in which you enter records is not always the
order in which you want to look at them later on . You
may need to view the records in alphabetical order to
find a particular record or to print out information from
the records . Or you may need to group the records by job
title so that you can easily compare salaries within job
classifications . All this can be accomplished by sorting the
records in different ways .

To sort the records, you establish the sort order by
selecting one or more fields. The first field you select is
the primary sort field (sometimes called the primary sort
key) . This instructs 4th Dimension to arrange the records
based on the entries in this field . For example, if your
primary sort field is Salary, 4th Dimension arranges the
records in order based on the entries in the Salary field .
The second field you select is a secondary sort field,
used to arrange records when the primary sort field has
duplicate entries. In the example presented here, you use
a secondary sort field because your primary sort field
may contain several duplicate values .
The data in the personnel database is now displayed in
the order the records were entered (from earliest to
latest Start Date) . Suppose, for example, that you want to
locate the record for Mary Smith to check on her salary,
but you don't know the date she started . You can find her
record most easily by sorting the records in alphabetical
order by last name .
1 . Choose Sort from the Select menu .

4th Dimension displays the Sort dialog box, showing a
list of field names from the current file and a set of
blank sort field cells (see Figure 5-4) . You use this
dialog box to set the sort order of the records .
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Current file

Field names

Sort field cells

Ascending symbol

You select field names from the list to establish the
sort order for the records .

2. Click on Last Name .
4th Dimension enters Last Name in the first sort field
cell . This instructs 4th Dimension to arrange the
records in alphabetical order, according to the entries
in the Last Name field .
The arrow in the box on the far right of the cell points
up, meaning that the sort is in ascending order (that is
from A to Z) .

3 . Because there may be several Smiths, click on First
Name.
4th Dimension enters First Name in the second sort
field cell . This instructs 4th Dimension to use the entry
in the First Name cell to arrange the records if there
are records with the same Last Name entries .

Sort EMPLOYEE
Last Name
First Name
Start Date
Salary
Title

S

Last Name

First Name 0

Cancel Sort

Figure 5-4
The Sort dialog box

Sorting the records
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4. Click on Sort .
4th Dimension displays some progress charts while
performing the sort ; then it displays the records in the
order you require .

5 . Select Mary Smith's record to highlight it on the
screen. You see that she is earning $26,650 .

Figure 5-5
Records sorted alphabetically

Suppose you want to see Mary Smith's record grouped
with other people having the same job title so you can
compare her salary to theirs .

6. Choose Sort from the Select menu .
7. Click on Title to enter this field in the first sort field

cell .
8. Click the arrow to change the sort from ascending to

descending order .
9. Click on Sort .

4th Dimension sorts the records and displays them in
descending alphabetical order by Title .
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EMPLOYEES : 23 of 23 J=
Last Name First Name Start Date Salary Title

Adler
Ambler
Anderson
Andrews
Ballard
Campbell
Davis
Donaldson
Frankheimer
Franklin
Johnson
Jones
Newton
Ranklin
Ransome
Smith
(Smith

	

I1°lary
Smith

Frank
'inifred

Nathan
Michael
John
Arnold
Tom
Bill
George
Marsha
Jasper
Samuel
Kendall
Anthony
Shirley
Jacky

Sally

10115186
09115186
02106186
08105186
08102186
12102186
01116186
07115186
01122187
07119186
04119186
03121186
01119187
07130186
02101186
09115186
11 /11 /86 I
02105186

29750
19450
39500
22500
27545
41 900
28500
31500
25660
32975
33490
21 500
38550
29966
29002
21 350

35567
26651:11Supervi_

Engineer 2
Engineer 1
Manager 2
Engineer 1
Engineer 1
Manager 3
Supervisor 1
Supervisor 1
Engineer- 1
Supervisor 2
Manager 1
Engineer 1
Manager 2
Supervisor 1
Supervisor- 1
Engineer 1

ir- 1
Supervisor 2

0



Figure 5-6
Records sorted by Job title

You can now see that Mary Smith's salary is
significantly lower than that of others with the same
job title .
The records for each department are grouped together .
However, within each department, they are again in the
order they were first entered into the database . The
sort order you previously established did not survive
the new sort order instructions .

Important When a data file is sorted, previous sort instructions no longer
have any effect. If you want the records sorted by Department
Code, Last Name, and First Name, you must enter these fields in
the sort field cells .

This principle applies to sort orders established by procedures as
well . Be sure to indicate the complete sort order you want to
use .

Sorting the records
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Last Name First Name Start Date Salary

	

Title

Smith Sally 02/05/86

	

35567 Supervisor 2
Tracy Joan 03/16/86

	

33590 Supervisor 2
Franklin Marsha 07/19/86

	

32975 Supervisor 2
Davis Tom 01 /16/86

	

28500 Supervisor 1
Ransome Shirley 02/01 /86

	

29002 Supervisor 1
Donaldson Bill 07/15/86

	

31500 Supervisor 1
Ranklin Anthony 07/30/86

	

29966 Supervisor 1
:,ri ilth I r°1 .~ra 11 ;'' 11 ;' ;r,

	

:=,up€r a l_ i, r 1

Smith Sally 05/12/86 45679 Manager 3
Williamson Tyler 05/19/86 41550 Manager 3
Campbell Arnold 12/02/86 41900 Manager 3
Anderson Nathan 02/06/86 39500 Manager 2
Newton Kendal! 01/1 9/87 38550 Manager 2
Johnson Jasper 04/19/86 33490 Manager i
Williams Alice 10/01 /86 25987 Engineer 2
Adler Frank 10/15/86 29750 Engineer 2
Wilson John 02/05/86 24500 Engineer 1
Jones Samuel 03/21 /86 21500 Engineer 1
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Searching for a specific group of records
You often need to isolate a specific group of records,
perhaps to view them together, to update each record in
the group, or to perform a calculation based on that
subset of all the records . 4th Dimension calls the subset
of records the selection .

You create a selection by searching. Searching for
records is based on search criteria, instructions that
identify the basis on which to search . If you want to see
the records for employees with salaries greater than
$30,000, your search criterion would be "Salaries greater
than 30000."

A search criterion always has this order : field name,
operator, value. The field name is from the current file .
The operator is drawn from among the familiar
comparisons of equal to, greater than, and less than . The
value is the value to which each record is compared .
Suppose, for example, that your client company requires
that each employee receive a performance evaluation in
the tenth, eleventh, or twelfth month of employment . You
want to view a list of employees who started between
nine and twelve months ago . You can use 4th Dimension's
search capability to perform that task quickly.
1 . Choose Search from the Select menu .

4th Dimension displays the Search editor . Here you
enter the criteria you want 4th Dimension to use to
search for specific records .
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Editor text area

Select operator

Select field name

Type in value

Search Editor

El

Save . . .
4 1

is equal to
is not equal to
is greater than
is greater than or equal to
is less than
is less than or equal to
contains
does not contain

load . . . Cancel OK

(Yalue

	

i /

Figure 5-7
The Search editor

Notice that you can save search criteria after you have
entered them or load search criteria you have
previously saved. If you need to perform the same
search on a regular basis, you should save the criteria
before you perform the search .

2. To enter the field name you want to use, click on Start
Date (in the panel at the left) .
4th Dimension enters the field name in the editor text
area .

3. To enter the operator you want to use, click on "is
greater than or equal to" (in the center panel) .

4. Enter the date of one year ago, 1 /16/86 (on the Value
line at the bottom) .
Note that you enter the date using the date entry
format you used in your first record . Again, you can use
slashes, periods, or hyphens to separate the numbers
for the month, day, and year.
This completes the first part of your search criteria .
You now need to enter the second part .

Searching for a specific group of records
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5 . Click the And button .
This prepares the editor to receive the second
criterion, to make the criteria complete. You want the
selection to include records that have a date greater
than (later than) one year ago and less than (earlier
than) nine months ago .

6 . Click on Start Date and then on "is less than or equal
to .

7. Enter the date of nine months ago, 4116186 .
This completes your search criteria .

is h3

	

Edit

	

i:ll ~ l ~l l rlE1

	

:n1 (F

	

S(((

	

(z *Jl 1

	

S p(( €€

Search Editor

F

	

EMPLOYEES
Last Name
First Name

4

Figure 5.8
Completed search criteria

is equal to
is not equal to
is greater than
is greater t_h_a_nsu - eryja_1_t_o

8. Click OK .
4th Dimension performs the search based on the
criteria you have entered. The selection of records is
displayed on the screen .
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Figure 5-9
The records isolated by the search

You see that there are seven employees in the
selection. You can use this information to check with
each employee's supervisor to see whether the
necessary evaluation has been performed or scheduled .

9 . To view all the records again, choose Show All from
the Select menu .
4th Dimension displays the entire file of records .

Modifying a record
You can use the User environment to work with a
database without having to customize it with special
menu commands and procedures . You will often need to
modify records that have already been entered .

To modify a record, you first select it :
1 . Click on the third record, the one for Sally Smith .

4th Dimension highlights the entire record .

Modifying a record 89
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Last Name First Name Start Date Salary Title

Davis Tom 01116186 28500 Supervisor 1
Ransome Shirley 02101186 29002 Supervisor 1
Smith Sally 02105186 35567 Supervisor 2
Wilson John 02105186 24500 Engineer 1
Anderson Nathan 02106186 39500 Manager 2
Tracy Joan 03116186 33590 Supervisor 2
Jones Samuel 03121186 21500 Engineer 1

a



Next record

First record

Previous record

2 . Choose Modify Record from the Enter menu .
	:• Note: The Modify Record command becomes active only

when a record has been selected .

4th Dimension displays the record in the input format .
Because you are modifying this record, the record
selection icon in the control panel is active . You can
use it to move from record to record in the database .

Figure 5-10
Moving from record to record

By clicking on the arrows or the stack of records,
you can display the next record, the previous record,
or the first record in the database . Any change you
make in a record becomes permanent when you
display another record .

3 . Click on the stack of records in the record selection
icon .
4th Dimension displays the first record in the
database, the record for Tom Davis .

4 . Click on the left arrow two times .
The record for Sally Smith is again displayed .
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J-Entry for EMPLOYEES

Enter
Employee Inforrmotion'	

#1 Lest Name

First Name

Smith

JS&i!J
elate

Start Date February 5,
Cancel

Salary $35,557 .00

Title (Supervisor 2

,



5 . Select the Title field and change her title to
Supervisor 1 .

6 . Click Enter .
4th Dimension displays the entire database again .
There is another way to search for records, using the
fields you have indexed . When you make a field
indexed, 4th Dimension creates a separate file to
keep track of the records according to entries in that
field. This makes searching and sorting that field very
fast .

7 . Choose Search and Modify from the Select menu .
4th Dimension displays the Index fields in a special
search box. Each field you have given the Indexed
attribute is shown in this box . You enter values next
to the field name you want to use .

8. Type Smith and click 4K .

EMPLOYEES

(Last Name Smith )

(First Name

Cancel ) f OK

Figure 5-11
The Search and Modify dialog box

Modifying a record
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4th Dimension displays the first record with Smith in
the Last Name field . This is the first of four records
that match the entry you made in the Last Name field .

9 . Click Enter and then click Cancel when the special
search box is again displayed .
4th Dimension displays the four records in the output
layout. By using the Search and Modify feature, you
have created another selection composed of records
that match the entry in the Search and Modify dialog
box.
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Figure 5-12
Selection of four records

10. Choose Show All from the Select menu to display the
entire database again .

[
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EMPLOYEES : 4 of 23 J

Last Name First Name Start Date Salary Title

Smith Sally 02105186 35567 Supervisor 1
Smith Sharon 05112186 45679 Manager 3
Smith Jacky 09115186 21 350 Engineer 1

Smith Mary 11 /11/86 26650 Supervisor 1



Further information

When you use the User environment, you can enter and

edit data and search and sort records. There are other

features of the User environment that cannot be covered

in this tutorial format .

Feel free to examine the other menu commands available

in the User environment. You will note that you can

create a standard columnar report and a graph very

quickly with commands from the Report menu . In addition,

you can import and export data by using commands in the

File menu .

Later chapters make use of this environment for

reviewing the work you have done in the Design

environment and testing procedures .

Further information
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Using Linked Files



Linked field is indexed

Arrow points from linking file to
linked file

Linking file

Linked file
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4th Dimension allows you to set up several files within a
database. These files can be related to each other in
various ways . One important way files can be related is
to be linked. When one file is linked to another, the
linking file can use information from the linked file .

Figure 6-1
A linking file and a linked file

The personnel database you are creating has two files,
although you have worked with only one so far . In this
chapter, you will link the two files . When you have
finished, the Structure window will look like the
illustration in Figure 6-1 .

Why link files?
Linking files makes it possible to store information in
one place, but make use of it in many places . It also
reduces the amount of data entry necessary and ensures
that the information is accurate . In addition, updating the
information is fast .

Structure or NEW J=PERSONNEL

EMPLOYEES DEPARTMENTS
Last Name

	

A Department Name A
First Name

	

A Department Code A
Start Date

	

D Manager

	

A
Salary

	

R Total Salaries

	

R
Title

	

A Budget

	

R
Department Code

	

A
Employee Number I



You are going to store information about your company's
departments in the Departments file . After you create the
fields and layouts for the Departments file and enter data,
the information looks like this :

Figure 6-2
Departments file data

Each department has one record . Each record has the
department name, the department code, the manager's
name, the total salaries for that department, and the
department budget. Notice that two departments have the
same name, though they use different department codes .
These are separate departments, performing the same
functions for different parts of the company .

You want to be able to see the department name and the
manager's name on each employee record . This
information already exists in the Departments file . If you
were to include it in the Employees file, you would be
duplicating the information. In addition, you would have
to store the department information once for each
employee.

Why link files?
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Department Name Code Manager Salaries Total 8u

Accounts Payable ACCP Mrs. Adams $66,150 .00
Accounts Receivable ACCR Mr. Hopkins $74,117 . 00
Administration ADMN Mr. Knowles $28,500 .00
Design DES Mr. Wanamaker $152,845 .00
General Management GENM Ms. Taylor $62,492 .00
General Management 0M2 Mr. Harvey $64,895 .00
Manufacturing MAN Mr. Hoffman $210,313 .00
Product Management PROM Ms. Wayfarer $112,244. 00
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When you link the two files, each record in the

Employees file can draw the necessary information from

the Departments file. The information can be stored in

only one place, the Departments file .

To link the two files, you must use a field from the

Departments file that identifies a unique record and

include that field in the Employees file . Then the entry in

that field can be used to identify exactly which

department record to use to provide information for the

employee record .

EMPLOYEES

Employee Number L_

Figure 6-3

Getting data from a record In a linked file

Code Department Manager Salaries Total

ACC.P Accounts

	

1 Mrs . Adams 150.00

R A

	

oun

	

tAla1.•e tvebIe Mr .
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ADM I N Administration Mr. Knowl es $28,500.00

r? n t

f A 1 nu edturin . ,~ n $210

	

0

PRO A R

	

M e Wo erer 1 12,244.00

Start Date 101/16/86

Last Name IDavis

First Name (Tom

Title (supervisor 1

Salary 28500

Department Code A(4 1I11

Department Name

Manager



The remainder of this chapter shows you how to draw the
link and then how to include the information from the
linked file in a linking file's layout .

Drawing the link
You establish a link between two files by drawing a line
that connects the related fields .
This tutorial begins where the last chapter leaves off . To
save you time, we have included an example database . To
follow this tutorial step by step, start 4th Dimension and
open New Personnel 3. This database includes both the
Employees file and the Departments file . The records for
the Departments file have been entered .
1 . Position the pointer on the Department Code field

name in the Employees file .
You must start with the Employees file because it is
the linking file. You can think of this file as the file
that needs the information . All of the procedures that
control the link will be associated with this file .

2. Click and hold the mouse button .
3 . While still holding down the mouse button, drag the

pointer to the Department Code field in the
Departments file .
A line follows the pointer .
The Departments file is the linked file. This is the file
that contains the information needed by the linking
file .

+ Note. The names of the linking field and the linked field do not
have to be the same. They must, however, be of the same field
type .

4. With the pointer directly on the Department Code field
in the Departments file, release the mouse button .

Drawing the link
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4th Dimension draws an arrow between the two files .
The arrow points from the linking field to the linked
field .

Figure 6-4
Drawing an arrow from the linking file to the linked file

When the arrow is drawn between the two fields, they
are linked .

Including a linked field in a layout
Your next step is to create a layout that includes the
linked field. This will be a new input layout for the
Employees file. On the same layout, you can include
whatever information you want from the Departments file .
1 . To open the Layout dialog box, double-click on the

title of the Employees file .
This is a shortcut for choosing Layout from the Design
menu. 4th Dimension displays the Layout dialog box
with the list of layouts for the Employees file already
expanded .

2 . Click New to bring up the New layout dialog box .

Structure J=for NEW PERSONNEL 3

EMPLOYEES Q DEPARTMENTS
Last Name Department Name A
First Name Qepartment Code A
Start Date ~+lanager

	

A
Salary Total Salaries

	

R
Title

	

A Budget

	

R
Department Code

	

A
Employee Number

ar
}c

	

1111.1

	

:1



Linked file In brackets

Linking field in bold type

Fields from linked file

If you accidentally select the
wrong field, double-click it again
to unselect it .

The linking field (Department Code) is shown in bold,
and the linked file is shown in brackets next to the
linking field .

3. Double-click on the Department Code field name .
4th Dimension displays the fields from the Departments
file . You can select any of these fields to include them
in the layout you are now creating .

New layout for EMPLOYEES

Select fields :
Last Name
First Name
Start Date
Salary
Title
i

-Department Name
Department Code
Manager
Total Salaries

_Budget
Employee Number

EP RT EMTS

Collapse

Select

Font size :

	

9 point
®12 point

00oeoeD=eoo

0000 000

CUSTOM

Layout name :

Layout3

Cancel OK

Figure 6-5
Including fields from the linked file In a layout

+ Note: Although selecting no fields to include in your layout
normally creates a layout containing all the fields, there is no
way to include linked fields without selecting them.

This means that you must individually select the fields you want,
including the fields from the Employees file and the fields from
the Departments file. Remember that the fields appear on the
layout in the order you select them in this dialog box .

4. Double-click, in order, on Employee Number, Start
Date, Last Name, First Name, Title, and Salary .
Double-clicking selects the field for inclusion on the
layout .

Including a linked field In a layout
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If you want to unselect a linking
field that you have accidentally
selected, click Select again .
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5 . Click on the bold Department Code field to select it
and then click on Select to include it in the layout .
You want to use the Department Code field from the
Employees file, not the one from the Departments file .
Normally, you can double-click on a field name to
include it in a layout . But because Department Code is
a linking field, double-clicking simply collapses the
display of Departments file fields and does not select
Department Code for the layout .

6. Finally, double-click on Department Name and Manager .

7. Enter the Layout name EmployeeEntry, make the font
size 9 and leave the first standard layout selected (the
left one in the middle row) .

8. Click OK .
4th Dimension displays first the EmployeeEntry layout
and then a short linking procedure.
The linking procedure appears in the Layout Proc . :
EmployeeEntry window in front of the new layout
window. The new layout and the procedure have the
same name .
4th Dimension has automatically generated this
procedure to search and load the linked record (the
record identified by the value in the linking field) . In
Chapter 11, "Using Input Layout Procedures," you will
see how to use this procedure as part of a more
complex layout procedure .

9. Rearrange and resize the windows on your desktop so
that both the Layout and the Procedure windows are
visible (see Figure 6-6) .



Command to load record

Variables defined In procedure

Variables shown on layout

0

Rrry

r-~
L_J

a

IiI'II'i

'I'll'''
b

Employee Number Em to

Start Date

Last Name

First Name

Title

Salary

	

Salar

Department Code	

Department Name

	

AG

Last

Start Date

Name

(First Name

Title

(Depart

Manager

Layout Proc . : EmployeeEntry
LOAD LINKED RECORD(Department Code)
A68 :=[DEPARTMENTS]Department Name
A09 :=[DEPARTMENTS]Manager

t

Layout: EmployeeEntry

Jai EMPLOYEES

AG

4 Routines
ABORT
Abs
ACTIVATE LINK
ADD RECORD
ADD SUBRECORD
ADD TO SET
After
ALERT

i File Edit Environment Design Font Style Layout Colors

Figure 6-6
Automatic procedure and layout

On the layout you have created, the fields from the
Employees file are shown in bold type . The two fields
included from the Departments file are shown in plain
type .
The field value for each of the linked fields is defined
as a variable. A variable is a named location in memory
capable of containing a value . A 4th Dimension layout
variable acts as a "nest" to display information held in
such a named location. In this case, the variables (AG8
and AG9) contain the department name and the
manager's name.
The area next to the linked field name contains the
variable name and has a diagonal line through it . This is
the way variables are displayed on a layout . The
variables are named in the procedure to instruct which
values to hold in memory and then to display from the
Departments file . For further information about using
variables, see Chapters 8, 9, and 11 .

Including a linked field in a layout
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Seeing the link in action
Now that you have linked the two files, you can use the
User environment to see how it will work in action .

This is a typical sequence: creating something in the
Design environment and then going to the User
environment to see how it performs .
1 . Choose User from the Environment menu .

4th Dimension displays some progress charts as it
generates the link and then it displays the default
output layout.
The default output layout is the layout you designated
as the output layout in the Layout dialog box . 4th
Dimension uses the default layouts at all times, unless
you change the default layout or designate another
layout temporarily with programming .

2. Choose the command Choose File/Layout from the File
menu.
4th Dimension provides this command so you can set
the layout and file you want to use here in the User
environment. This is called "changing the default
layout ."

3. Double-click on the Employees filename to reveal the
list of layouts for that file .

4. Click on EmployeeEntry to select it ; click Input to
make it the default input layout ; then click Choose .
The Choose File/Layout dialog box is put away .
4th Dimension displays the same layout as before you
haven't changed the default output layout, only the
layout used for input has changed .

5. Choose New Record from the Enter menu .
4th Dimension displays the layout you have created,
ready for you to enter information .



6. Select the Department Code field .
7. Enter DES .

Instantly, 4th Dimension enters the department name
and the manager's name in the correct locations . This
information came from the Departments file . This is the
first benefit of the link you have established :
automatic, instantaneous, accurate data entry .

Flgura 6-7
A record with linked data entered automatically

8. Click Enter .
4th Dimension displays the "I cannot accept this
record" message. You made Last Name mandatory, so a
record that does not contain a last name is not accepted .

9. Click the Re-enter Record button . Enter Walden in the
Last Name field and Jeff in the First Name field . (The
First Name field is also mandatory.) Then click Enter .
4th Dimension accepts the record and displays a blank
record for further data entry .

Seeing the link in action
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Access to the linked file

Occasionally, you will need to update the linked file
while working with the linking file . For example, you
may need to create a record for a new department . 4th
Dimension makes this very easy ; when you enter a new
Department Code, 4th Dimension gives you access to the
Departments file to create the new record .

Suppose your company hires a new engineer as the first
employee to join a new art department . When you first
enter this record, the department does not yet exist .
1 . Enter ART in the Department Code field .

4th Dimension displays the "This record does not
exist" message and offers to let you create it .

This record does not enist in file
"DEPARTMENTS"
What do you wont to do?

Create It J c Try Again

Figure 6-8
Creating a new record in the linked file

+ Note, The Department Code field in the Employees file has the
attribute Mandatory. Applied to a linking field, the Mandatory
attribute allows this kind of access to the linked file .

2. Click on Create It .
4th Dimension displays the input layout for the
Departments file . The new Department Code is already
entered in the correct field . All you need to do to
create a new record in the Departments file is fill out
the rest of the form .

3. Enter the new department name ART DEPARTMENT, the
manager's name Mr . Sturges, and the budget 69000 .



You can ignore the Total Salaries field for the moment .
This field has a Display Only attribute that prevents
any value from being entered . Later, you will instruct
4th Dimension to calculate a value for this field .

4. Click Enter .
4th Dimension accepts the record, returns to the
Employees input layout you are using, and displays the
department information in the linking fields .

5 . To complete this record, enter Employee Number 24,
Start Date 3116187, Last Name Johnson, First Name Billy,
Title Engineer 1, and Salary 26500 . Then click on Enter .

6. Click Cancel to get back to the list of records .

Further information
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Chapter 7

Using Subfiles



Parent file

Gray line from parent file to
subfile

Subflle

Subfields
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In the personnel database you are working on, you have
decided to store performance reviews for each employee .
You have no way of knowing off hand how many reviews
a particular employee has had . New employees have had
no reviews ; others who have been with the company a
long time, have had many reviews .

4th Dimension allows you to create a subfile to handle
just this kind of problem . A subfile is a complete file
associated with a field in a parent file . The parent file is
the file to which the subfile is directly attached . Every
record in the parent file can contain a complete set of
subrecords . A subrecord is a record in a subfile . You use
a subfile most often when you need to keep track of a
varying number of additional entries for each record .

Structure for NEW PERSONNEL	

Rr
ry

EMPLOYEES
Last Name
First Name

	

A
Start Date

	

D
Salary

	

R
Title

	

A
Department Code A
Employee Number I
Review Info

Review Info
Review Date D
Comments
Rating

Figure 7-1
A parent file with a subfile

}

T

DEPARTMENT°
Department Name A
Department Code A
Manager A
Total Salaries R
Budget

You are going to set up a subfile to keep track of
performance-review comments and ratings . Each employee
record will have an entire data file in which to store
such information. When you have finished, the Structure
window will look like the illustration in Figure 7-1 .



Creating a subfile
You create a subfile in two distinct steps : you add a field
to the parent file, and then you make the new field a
Subfile field type .
Notice that this is quite different from creating a link
between two files that already exist . You cannot make a
file that already exists into a subfile .

This tutorial begins where the last chapter leaves off. If
you want to follow it step by step, start 4th Dimension
and open the New Personnel 4 database . If you are
continuing directly from the previous chapter, choose
Design from the Environment menu to return to the
Design environment .
1 . Double-click in the space below the field names in

the Employees file .
This is a shortcut for choosing New Field from the
Structure menu . 4th Dimension displays the Add or
Change Field dialog box .

2 . Enter Review Info for the field name .
This is the name that 4th Dimension will use for the
name of the subfile . If you want to change the
filename later, you must edit this field name .

3 . Click on the Subfile field type button .
A subfile is a field, because the entire set of
subrecords relates to a field in one record . Each
record in the parent file has its own subfile. The
subrecords act like a field entry .

4 . Click OK .

Creating a subfile
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4th Dimension creates the subfile, drawing a gray
line from the field to the top of the subfile. Note that
the subfile line and the link arrow are different
colors (gray and black) and that they point to
different places (to the top of the subfile and to the
linked field) . This is how the Structure window
distinguishes the two kinds of files .
You may need to change the size of your Structure
window to show the entire subfile .

Figure 1-2
A new subfile

Once the subfile is created, the next steps are the same
as for a regular file . You establish subfields by selecting
the new empty subfile and then choosing New Field from
the Structure menu . You name the fields and set the field
types and attributes . You then create input and output
layouts and set the display formats for the fields. All this
is familiar to you from Chapter 4, "Creating a New
Database ."



5 . Create the following subfields in the Review Info
subfile :
Review Date (a Date field)
Comments (a Text field)
Rating (a Real field)
The Review Date field will, of course, contain the
date the performance review is approved. The
Comments field will contain the text of the
performance review itself. You have made it a Text
field so that it can hold up to 32,767 characters . The
Rating field is for the numerical rating your company
uses to obtain statistics from performance reviews .

6 . Using the same layout pattern you used for the
previous input layouts, create an input layout for the
Review Info subfile named Review Input (see Figure
7-3) .

Figure 1-3
An input layout for a subfile

Creating a subfile
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This input layout will be referred to later on as a
Full Page layout because it provides access to one
record per page. You use the same standard layout
pattern you have been using for this database so that
you create a consistent visual style for all the
layouts .
For this layout, you have modified the standard layout
pattern. The Rating field has been moved to the same
line as the Review Date field, and the Comments field
has been expanded to accommodate paragraphs of text.
If you are following along using the sample database,
you will note that each field is separate from the
field name and the additional box used for decoration .
They must be selected, moved, and resized separately .

7 . Using the same layout pattern you used for the
previous output layout, create an output layout for
the Review Info subfile named Review Output (see
Figure 7-4) .

r- i
L_J

I1111111

b
b

IReview Dat! Comments Rating)

-~	 Layout: Review Output	 P1

ry

File Edit Environment Design Font Style Layout Colors

Review

	

Comments
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Figure 7-4
An output layout for a subfile



This output layout will later be referred to as a
Multi-line layout because it presents several records
on a list .
Notice that you have expanded the Comments field so
that two lines of the comments text will appear on
the output layout . In many cases, this is enough to see
the most important part of the performance evaluation .
Layout hint: You can similarly expand any field . The data
entered will wrap to fill as many lines as there is room . This is
particularly useful when you don't know the exact size of an
entry. An address, for example, can have a varying number of
lines depending on whether the address includes a job title,
company name, suite number, and so on .

8 . In preparation for the next step, draw a rectangle
that exactly covers the layout you have created .
The rectangle temporarily hides your layout (see
Figure 7-5) . You are going to copy this rectangle to
the Clipboard so that you can provide exactly the
right amount of area to display the review
information in the parent file's layout .

=iI	 Layout : Review Output	 ~-

File Edit Environment Design Font Style layout Colors

r-~

L J

JWUJL

Figure 7-5
The rectangle temporarily hiding a layout

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4
H

'50

9 . Choose Cut from the Edit menu .
Cut removes the rectangle from the layout and places a
copy of it in the Clipboard of the Macintosh .

Creating a subfile
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10 . You have finished creating the subfile, so choose
Structure from the Design menu to return to the
Structure window.

Now you are ready to learn about one additional difference
between a subfile and a file : you must display the subfile's
layouts in a layout from the parent file. A subfile cannot be
displayed independently of its parent file . The procedure is
shown in the next section .

Displaying the subfile
Now that your subfile exists, you need to display it to
enter information into its records . A subfile is subordinate
to its parent file . In fact, a subfile is "nested" in each
record of the parent file . The layouts you have created for
the subfile cannot be displayed independently . You must
add an area on the parent file's layout to display the
subfile's layouts .
You will display the output layout of the Review Info
subfile on the input layout of the Employees file .
1 . To open the Layout dialog box, double-click on the

title of the Employees file .
2 . Click on EmployeeEntry and then click Open .

4th Dimension displays the input layout you designed
in Chapter 6 .

3 . Click the zoom box on the right side of the Layout
window to bring the bottom of the layout into view .
You need to add a little room to display the subfile's
output layout .

4 . Click on the border . Then position the pointer on the
lower-right handle. When it turns into a pointer with
four arrows, drag the handle down to enlarge the
border .
This adds enough room within the border for the
output from the subfile .



Include File icon

Border

S . To paste the rectangle that you cut from the subfile's
output layout, choose Paste from the Edit menu .

6 . Drag the rectangle down until it is in position near
the bottom of the border. To fit the rectangle, you
may need to move fields to different locations .
You are trying to fit the rectangle conveniently into
the original layout (see Figure 7-6) .

File Edit Environment Design Font Style Layout Colors

Layout : EmployeeEntry

r-~
L_J

EMPLOYEE INFORMATION

`50

. 100

- 150

-

Figure 7-b
Adjusting the layout to accommodate the subfile's output

7 . When you have found a pleasing arrangement of
elements, select the rectangle again and then press
Backspace to delete it .
You are using it only to determine the size of the
area you need.

S . Select the Include File icon from the palette .
This instructs 4th Dimension to use the next
rectangle you draw on the layout as a display area for
an included file (such as a subfile) .

I

Displaying the subfile
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9 . Draw a rectangle in the position you want for the
subfile display .
This is the area in which 4th Dimension will display
the output from the subfile . You know that the area
you have drawn is large enough because you used
your rectangle template .
When you release the mouse button, 4th Dimension
displays the Format for an included layout box (see
Figure 7-7) . You use this dialog box to tell 4th
Dimension which subfile to display in the area you
have just drawn and which of the subfile layouts to
use for input and which for output .

10 . The Review Info subfile name is highlighted, ready to
be selected. Click on Select .
4th Dimension puts an asterisk next to the filename .
This shows that Review Info is the subfile that will
be displayed in the subfile area you have just drawn .

11 . Click on Expand to show the list of layouts you have
created for Review Info .

12 . Click on Review Output and then click the Multi-line
check box .
This makes the output layout you designed the layout
that will be displayed in the subfile area . Remember,
the included-file area is used for multi-line output
from the subfile (even though it is included on an
input layout) .

13 . Click on Review Input and then click the Full Page
check box .
This makes the input layout you designed the Full
Page layout that "waits behind" the subfile area until
you signal to enter more data . You will see this
feature in action in the next section of this chapter .
Ignore the buttons for the different frame displays ;
they are used only during printing .



Format for an included layout . . .

See

® Full Page

0 Multi-line

Cancel

r

Print using . . .
0 Variable frame
O Fisted frame (truncation)
® Fined frame (multiple records)

Figure 1-1
Format for an included layout dialog box

14. Click OK .
4th Dimension displays the layout .

15 . Add a text area above the subfile area ; then type
Performance Reviews .

The Text Area icon has a capital A in it . Once you
click the Text Area icon, the pointer becomes a + .
Use this pointer to define a rectangle (the text area) .
After you have done so, the I-beam pointer sits at the
left of the area, ready for you to enter text .

EMPLOYEE INFORMATION

Employee Number

Start Date

Last Name

First Name

Title

Manager

PERFORMANCE REVIEWS :
c

Istart Date I
Em la

Last Name

(First Name

Title

IAG

Department Code IDepartr

Department NamelA	

Salary Salar

Review Info

Figure 7-8
The completed layout including the subfile's output

I
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Seeing the subfile in action
Now that you have a layout with a subfile displayed in it,
you can use that layout to enter and view information . To
do so, you will use the User environment, just as you did
with the linked files in the preceding chapter .

These instructions assume that you have just completed
the previous section . If you have not completed the steps
in this chapter, you can follow along from here by
starting 4th Dimension and opening New Personnel 5 .
1 . Choose User from the Environment menu .

4th Dimension changes to the User environment,
displaying the current output layout .

2 . Select the first record in the list .
This is Tom Davis's personnel record .

3 . Choose Modify Record from the Enter menu .
4th Dimension displays the employee record for Tom
Davis .

EMPLOYEE INFORMATION

Employee Number	1

	

Department Code

Start Date 01116186

Last Name Davis

First Name Tom

Title

	

Supervisor 1

Manager

	

MR. VILSON

PERFORPIANCE RE'v'IEW : :

Department Name ADMINISTRATION

Salary

ADF 1IN

28500

Review

00/00100

Comments Rating

0

v

Figure 7-9
A record with a subfile



4. Double-click anywhere within the subfile area .
4th Dimension displays the Full Page layout for the
Review Info file! This is what was meant by the
Review Input layout "waiting behind" the subfile area .
To display the Full Page layout, you simply double-
click on the Multi-line layout!

5 . Enter the following information for Tom Davis :
Review Date: 3116/87
Rating : 4 .5
Comments: Tom has had a very successful quarter, meeting all
his stated goals. In particular, his report on the need for the new
Art Department was effective in getting it established .

During the coming quarter, his goal is to establish budget and
scheduling parameters for the coming year; this means working
directly with Bud Schulberg .

Notice that the text area for comments works like a
word processor. The words wrap from line to line
within the borders of the field area .

PERFORMANCE REVIEW RECORD

Review Date 103116187		Rating I

	

4 .5

Comments

Tom has had a very successful quarter, meeting all his stated
goals . In particular, his report on the need for the new Art
Department was effective in getting it established .

During the coming quarter, his goal is to establish budget and
scheduling parameters for the comin year ; this means
working directly with Bud Schulberg

Figure 7-10
Entering comments into a text field

Seeing the subfile in action 121
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8. Click Enter .
The record is accepted . 4th Dimension displays the first
two lines of the comments in the subfile area . More
lines of text would display if the area for the
Comments field had been drawn larger .
You can enter more subrecords by double-clicking in
the white area below the first subrecord . You can also
enter new subrecords by pressing Command-Tab, a
method that is described in Chapter 3 of 4th Dimension
User's Guide .

EMPLOYEE INFORMATION

Employee Number I	1

	

Department Code ADMIN

Start Date 01 %16186 Department Name ADMINISTRATION

Last Name Davis

First Name Torn

Title

	

Supervisor 1

Manager-

	

MR. WILSON

PERFORP1 ANCE RE4' IEWS :

Salary 28500

Review

03/1618?

Comments

Tom has had a very successful quarter,,
meeting all his stated goals . In particular,

Rating

	

S-~

~

4,5

Figure 7-11
The first two lines of comments displayed

Further information
Because Review Info is a subfile, you can enter as many
records as you want for each employee . You can create
procedures for special processing, including calculations,
statistical functions, and any processing that can be done
within files. Information in subfiles can be used in
reports, given the proper procedures .



Chapter 8

Using Layout Variables



The control panel Is removed
when you add any kind of
button or ckeck box to your
layout .
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You have decided to create a set of buttons for accepting
or canceling records during data entry . When you design
your own OK and Cancel buttons, you can place them
exactly where you want them on the layout . Figure 8-1
shows the final result . Note that the original set of
buttons (the control panel) has been deleted . 4th
Dimension automatically removes the control panel when
you create custom buttons .

Figure 8-1
Custom buttons added to an input layout

You add these buttons to your layout by using 4th
Dimension's layout variables. A variable is a named
location in memory that can contain a value . You are
undoubtedly familiar with variables in programming . 4th
Dimension allows you to use layout variables on your
layouts without having to create the programming that
controls the graphic display. This makes it easy to create
different Macintosh buttons, check boxes, areas to
display graphs, and scrollable areas from which to select
items in a list .
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Entry for EMPLOYEES
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EMPLOYEE INFORMATION

Employee Number

Start Date

1

	

Department Code
101116186

	

Department Name

ADMN
OK

( OK and Neat

Last Name

First Name

Title

Manager

PERFORMANCE

JDavis

I

	

28500

CancelTom

(Supervisor 1

	

Salary

REVIEWS

Review Comments Rating Q

03116187 Tom's first year has been a very good
beginning for what we hope will be a long

5



In this chapter, you will learn the steps necessary to
create the customized set of OK, OK and Next, and
Cancel buttons. Adding these button variables to your
layout is also an introduction to adding any of the layout
variables . Although each type of variable performs a
specific task, the steps to enter one on a layout are
always the same .
This tutorial begins where the last chapter leaves off . To
follow this tutorial step by step, start 4th Dimension and
open the New Personnel 5 database .

Creating an OK button
Up to now, you have been using the standard Enter and
Cancel buttons provided by 4th Dimension for your input
layout. You can create your own custom buttons (called
Accept and Don't Accept), placing them where you want
them in the layout and including your own text on them .

In fact, you want to add three buttons to your layout . The
third button, OK and Next, will act like an OK button
except that it will also bring up another blank record for
entering data .
1 . Choose Layout from the Design menu, expand the

Employees file to see the layout names, and select and
then open the EmployeeEntry layout .

2 . Click the zoom box on the upper-right corner of the
window .
The Layout window takes the entire screen .

3. Scroll the display so that the area to the right of the
border is visible .
You are going to position the buttons outside the
border, separate from the data entry portion of the
layout .

Creating an OK button
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Zoom box

Create Variable Icon

Vertical ruler

Horizontal ruler

4 . Click the Create Variable icon on the palette .
This informs 4th Dimension that the next area you
define on the layout is to contain a variable value .

5 . Draw a rectangle to the right of the frame, about 1-1/4
inches long and 1/4 inch high . Start at the same level
as the line beneath Employee Information .

n
C

File Edit Environment Design Font Style Leyou

	

Colors

0	 Layout : EmployeeEntr	 = .
R

J

qpp~

b
b

YEE INFORMATION
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Department Code

Department Name1A	

Salary Solar

(Depart

0	200	250

	

300

	

350 400 450

Figure 8-2
The layout ready for positioning custom buttons

500

'50

' 100

'150

`200

DB
F

s

When you release the mouse button, 4th Dimension
displays the Format of variable dialog box . Here you
enter the name for the variable, the type of variable,
and the text you want the button to display . (For
numeric, date, or picture variables, you can also set the
display formats as well .)



Format of variable . . .

Variable name :

Enterable Variable
C) Non-enterable Variable
O 'Accept" Button
C' "Don't accept" Button
,Button
0 Check Bou
O Radio Button
0 Graph Area

Scrollable Area
Enternal Area

Format :

Cancel

Collapse

l

Figure 8-3
The Format of variable dialog box

6. Type the variable name, in this case xOK .
This is the name you will use when you refer to this
variable in programming .

7 . Click the Accept Button button .
This defines the variable area on the screen as a hot
area for accepting a record . When your user clicks on
this area, 4th Dimension accepts the record into the
database .
4th Dimension changes the Format box to the Button
Text box .

8 . Select the Button Text box and type OK .
OK is displayed in the variable area . You could have
entered anything-Enter, Accept Record, and so on .

9 . Click OK .
4th Dimension displays the layout again, this time with
your variable in it . Note that the rectangle you drew
has changed to a shape with rounded corners . 4th
Dimension automatically sets this shape for Accept and
Don't Accept buttons to match the regular Macintosh
format for this kind of button .

Creating an OK button
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Additional buttons

Align Center/Vertical Icon

Duplicate icon
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Duplicating and editing buttons
For your screen design to look good, you want the OK,
OK and Next, and Cancel buttons to be the same size. The
easiest way to accomplish this is to duplicate the variable
you just finished and then edit the variable definition in
the Format of variable dialog box .
1 . If necessary, click the OK button you just created to

select it. Then click on the Duplicate icon twice .
4th Dimension creates two copies of the OK button .

Figure 8-4
Using the Duplicate icon
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2 . Drag each copy in turn to its proper location .
You want the three buttons to line up beside the
frame of the input layout .

3 . To align the three buttons exactly, shift-click on all
three to select them as a group and then click the
Align Center/Vertical icon .
4th Dimension aligns the buttons in relation to each
other .

4 . Now double-click on the middle button .
4th Dimension displays the Format of variable dialog
box again. The instructions are the ones you entered
for the OK button . To change the instructions to make
this button the OK and Next button, all you need to
do is change the variable name and the button text .

5 . Enter xNext as the variable name .
This is the name you will use in programming for the
OK and Next button. This button also serves as an
accept button, so leave the Accept button marked .

6 . Enter OK and Next as the button text .
7 . Click OK .

4th Dimension displays the layout again . The middle
button has become the OK and Next button .

8 . Double-click on the lowest button .
4th Dimension again displays the Format of variable
dialog box . You are going to make this the Cancel
button .

9 . Enter xCnncel for the variable name and Cancel for the
button text .

10 . Click the Don't Accept button .
This changes the button from an Accept button to a
Don't Accept button . The exact way that each of these
buttons works is discussed in a later section .

11 . Click OK .

Duplicating and editing buttons
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11 . Click OK .

Your layout is finished ; it includes the set of custom
buttons you have entered .

Q 0 Quj

	

Department Code

oo~

ddii~i

Department NamelA	

Salary Salar

(Departrl

RT
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eeEntry
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OK and Nent

Cancel

50
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5`	J I J I l l l l l 1 J I J I t I J I J I J I J I l 1 J 4141 1	'
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. 100

'150

"200
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0 F

Figure 8-5
The completed layout with the custom buttons

Seeing the custom buttons in action
As you found in the previous chapters, you can go quickly
to the User environment to check on work you finish in
the Design environment .

You want to check to see the effect of these new buttons .
Because 4th Dimension removes the standard control
panel when you create your own OK and Cancel buttons,
you particularly want to see how the new buttons affect
the screen design of the rest of your layout .



Marlys Wilson has been hired in the Art Department ; her
title is Supervisor 1 ; she started 3/16/87, at a starting
salary of $25,687 . Her employee number is 25 . You are
going to use your new layout to enter her employee
record .
1 . Choose User from the Environment menu .
2 . If necessary, choose the command Choose File/Layout

from the File menu and make EmployeeEntry the
current input layout .
You probably recall this procedure from Chapter 6,
"Using Linked Files."

3 . Choose New Record from the Enter menu .

Figure 8-6
Seeing the layout in the User environment

Seeing the custom buttons in action

	

1 31

Entry for EMPLOYEES J=

EMPLOYEE INFORMATION

Employee Number 0 Department Code
OK

	

)

Start Date 00/00/00 Department Name ( OK and Neat )

Last Name Cancel
First Name

Title Salary

Manager

PERFORMANCE REVIEWS

(Review ICamments Rating Q
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4th Dimension has removed the standard control panel
from the left side of the screen. Now your custom
buttons are arranged on the right side of the screen .
The control panel includes a Delete button, which you
have not included in your buttons . You plan to create a
separate Delete procedure that uses a dialog box and
special programming to update other files in your
database .

4 . Enter the information for Marlys Wilson :

Employee Number :

	

25
Department Code :

	

ART
Start Date :

	

3116187
Title :

	

Supervisor 1
Salary :

	

$25,687

5 . Click OK .
4th Dimension accepts the record and displays another
blank record. The OK button you have added works
with no additional programming .
You notice that 4th Dimension has displayed another
blank record for you to use . This is the standard way
4th Dimension operates when an Accept button is
activated . However, you want the OK button to accept
the record and then return control to the menu bar ; you
want the OK and Next button to accept the record and
display a new blank record. You can control the way
these buttons operate with your programming
procedures . See Chapter 9, "Using Global Procedures ."

6. Since you have no more records to enter, click Cancel .
4th Dimension returns the output layout to the screen .
Your new record is visible in the list .



Further information
A variable, in general, is a named location in memory that
can hold a value . You assign values with the assignment
operator (:_) meaning "gets" or "becomes ." This is the
same operator used in Pascal .

For the layout variables, you assign a variable name to a
particular location on the screen, using the Layout editor .
You then use procedures to instruct 4th Dimension how
to handle the variable you have created .

Using layout variables saves you quite a lot of
programming time because you don't have to program how
the variable works or the graphic representation of the
variable. You simply draw the location and shape of the
variable, assign it a name and type, and enter necessary
text and format instructions .

Programming the button variables
Button variables, such as the buttons you added to your
layout, are initially set to zero (0) unless your program
sets them differently. When your user clicks the button,
the value changes to one (1) .

Of course, you set the variable values in relation to
other programming instructions . You plan to use the
layout in this chapter for adding records to your database .
The problem you want to solve is to have 4th Dimension
display a new blank record after OK and Next, but not
after OK. One way to do this is illustrated in the next
chapter, "Using Global Procedures ."

The Accept button is the same as the system OK button . If
your user clicks an Accept button, it sets the system OK
variable to 1 and accepts the current data .

Further information
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If your user clicks a Don't Accept button, it sets the
system OK variable to 0 and cancels whatever data has
been entered into the fields .

Other layout variables

The other layout variables perform different functions .
You assign the type in the Format of variable dialog box .
∎ Enterable and non-enterable variables : These variable

types let you see data stored in other files and data
that is the result of calculations . Making a variable
"enterable" is meaningful only in a dialog layout ; in an
input layout or an output layout, the enterable and non-
enterable variables are exactly the same : they can be
used to display a variable value .

∎ Button variables : The plain button creates a button
similar to the Accept and Don't Accept buttons, except
that it does not affect the system OK variable . In other
words, it does not accept or reject records, and it does
not leave the data entry screen .

∎ Check Box and Radio Buttons : These are additional
button variables to enable or disable options . Check
boxes can enable several options at the same time .
Radio buttons require that only one option in a group
be enabled, leaving the others disabled . These buttons
are used in the example in Chapter 3 to enter values
into fields .



EMPLOYEES

Last Name

	

(Wilson

First Name

	

(John

Address

	

I14 W. Main

City 	Bleaker

Phone No

	

699-3304

0 Male

~Q Female

Input layout

Variable memory

Procedure :
If (bMale=1)

sex :="M"
Else

sex ;="F"
End if

Empno 3042
Name Smith
Street

	

Bay
Aloma

Sex

	

M

Current record memory

Figure 8-7
How layout buttons are used to enter values into fields

∎ Graph Area: This variable establishes a location to
display a graph. You can create a graph of values stored
in a file or subfile with programming commands . The
graph of performance evaluations in Chapter 3 is
displayed in a graph area .

∎ Scrollable Area: This variable creates an area with a
scroll bar to display a list of values that can be
selected. The scroll bar is activated when the list
displayed is too long to view completely . You use
programming commands to create the list of values to
be displayed .

∎ External Area: This variable creates an area in which
the user can click to display the results of external
programs .

All of these variables are discussed in detail in 4th
Dimension User's Guide and 4th Dimension Programmer's
Reference .

Further information
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You plan to create an entire set of custom menus and

write the necessary programming to run your custom

personnel application . In this chapter, you will learn how

to write the procedure for adding an employee record to

the database. In the next chapter, you will see how this

procedure is called by a menu. You need to write a

procedure for each menu item you use on a custom menu

and for any standard procedures you use within other

procedures (subroutines) . 4th Dimension calls these

global procedures to distinguish them from layout

procedures (which are associated with specific layouts) . A

global procedure can be called from a menu command or

from another procedure.

As part of the procedure to add a record, you plan to

disable all the inappropriate menu commands while the

record is being added and then enable them when the

data entry process is finished (see Figure 9-1) .

Figure 9-1

Disabling menu commands during data entry
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Procedure list area

Layout display area

You decide to write the procedures for enabling and
disabling menus as separate global procedures because
you want to use them in other procedures . These
procedures will function as subroutines that you can use
in any procedure .

This tutorial begins where the last chapter leaves off. To
follow along step by step, start 4th Dimension and open
the New Personnel 6 database .

Getting to the Procedure editor
Whenever you write a procedure, you use 4th
Dimension's Procedure editor .

To get to the Procedure editor :
1 . Choose Procedure from the Design menu .

4th Dimension displays the Procedure dialog box .

Global Procedures
File/Layout Procedures

Name :

Sort

New

K )
Done

Figure 9-2
The Procedure dialog box

Getting to the Procedure editor 139
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At this point, before any procedures have been created,
there are no global procedures. Later, you will be able
to expand and collapse the list to see the, procedures
that you have created . (This works like the Expand and
Collapse button in the Layout dialog box .)
You must indicate on this screen whether your
procedure is global or layout . Because you are writing
a procedure to use as a subroutine, it is a global
procedure. The Global Procedures choice is
automatically selected, so you don't need to change it .

2. Click New .
4th Dimension displays the Procedure type dialog box .

Procedure type . . .

® listing

Procedure ;

0 Flowchart

Disable All

Cancel
D

OK

Figure 9-3
The Procedure type dialog box

Here you choose whether to use the Listing or the
Flowchart method for writing your procedure .
If you are accustomed to using flowcharts to map out or
diagram your procedures, you may find the Flowchart
method appropriate . However, most people are familiar
with a listing format, in which the procedures are
written out line by line .

3 . Type Disable All in the Procedure box .
This is a descriptive name for the procedure you will
write. This is the name you will use when you want to
call this procedure in programming .



Procedure editor area

Window split bar

The choice between the two methods is available only

for a new procedure. Subsequently, you can edit the

procedure only in the form in which you first write it .

4. Since the Listing button is automatically selected,

simply click OK .

4th Dimension displays a Procedure window with the

procedure name as part of the title . You have reached

the Procedure editor .

Figure 9-4

The Procedure editor in a Procedure window

Creating a global procedure

Now that you have reached the Procedure editor, you are

ready to create the global procedure that disables

unnecessary menu commands. 4th Dimension leaves menus

active at all times; this global procedure will prevent

having to trap inadvertent menu commands . In the next

section, you will see how to copy this procedure and edit

it to enable the menus again .

The command you will use is DISABLE ITEM. This is the

specific command for disabling menus in 4th Dimension .

Creating a global procedure
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Keywords F

	

EMPLOYEES

	

4 Routines
_ Q Last Name 4Q ABORT

If First Name
^

Abs
Else Start Date ACTIVATE LINK
End if Salary ADD RECORD
Case of ` Title ADD SUBRECORD

Department Code ADD TO SET
End case '

	

: . Employee Number After
While Review Info ^Q ALERT



Menu title
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This application example uses five custom menus. (The
menus you create are displayed in addition to the
automatically created Apple and Edit menus .) You
reference these menus with numbers 1 through 5,
counting from the left .

1

	

2

	

3

	

4

	

5

* File Edit Departments Employees

Search and Modify . . .
Modify From list . . .

. . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . .
Remove Employee

Figure 9 .5
Standard Apple menus and custom menus

In Figure 9-5, the five custom menu titles are File,
Departments, Employees, Menus, and Utilities .

Because you are going to disable all the menu commands
on all the menus, you don't need to know what each menu
contains. (To disable a specific menu item, you would
need to know what commands are on the menu .)
To disable menus :
1 . First enter the following comment to identify the

purpose of this procedure :

'Disables all menus

The leading accent mark indicates that this is a
comment, not part of the instructions. The accent mark
is on the top left of the Macintosh Plus keyboard, just
above the Tab key .
When you press Return, the comment is entered and
automatically indented .

2 . Use the scroll bar on the right side of the Routines
column to scroll the list until the DISABLE ITEM
command is visible .



+ Note: 4th Dimension does not distinguish between capital and
lower-case letters . When you enter a command, 4th Dimension
changes the display to its own style . The commands are
capitalized here as they are finally displayed by the program .

3. Click on DISABLE ITEM .

4th Dimension enters the command into the procedures
area, making it bold type as well .

Figure 9-b
Entering a command by clicking on it

The DISABLE ITEM command requires additional
information : you must reference the menu and the menu
item you want to disable .

4. Type (1 ;0) and press Return .
These additional parameters instruct 4th Dimension to
disable all items on menu number 1 (counting from the
left, the File menu) . The first of the two numbers
identifies the menu . The second number identifies the
menu item on that menu. Because you want to disable
all the menu items, you enter 0 . To disable all items on
menu number 2 (the Departments menu), you will enter
(2 ;0), and so forth .

5 . Enter DISABLE ITEM and the correct additional
parameter for each of the five menus you want to
disable .

Creating a global procedure

	

143
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'Disables all menus

DISABLE ITEM

Keywords F

	

EMPLOYEES

	

4 Routines
=

If
Else
End if
Case of

End case
While

Last Name
First Name
Start Date
Salary
Title
Department Code
Employee Number
Review Info

{} DIFFERENCE
DISABLE BUTTON
DISABLE ITEM
DISPLAY RECORD
DISPLAY SELECTION
During
ENABLE BUTTON
ENABLE ITEM^Q'
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When you have finished, your procedure looks like
this :

Figure 9-7
The Disable All procedure

The Disable All procedure you have written instructs
4th Dimension to disable all the menus it controls
whenever this procedure is called . You can now write
the global procedure that turns the menus back on .

Editing a global procedure
Once a menu is disabled, you need a way to enable it
again. You notice that the ENABLE ITEM command is
exactly the same as the DISABLE ITEM command, except
for the first letters . You decide to copy the Disable All
procedure and edit it.
1 . Choose Procedure from the Design menu .
2 . Type Enable All as the procedure name and click New .
3 . Click OK on the Procedure type dialog box .

4th Dimension displays a blank Procedure window
titled Procedure : Enable All .

Procedure : Disable All J=
'Disables all menus

DISABLE ITEM(1 ;O)
DISABLE ITEM(2 ;0)
DISABLE ITEM(3 ;0)
DISABLE ITEM(4 ;0)
DISABLE ITEM(5 ;0)

Keywords F

	

EMPLOYEES

	

4 Routines

=
If
Else
End if
Case of

End case
While

Last Name
First Name
Start Date
Salary
Title
Department Code
Employee Number
Review Info

Q DIFFERENCE
DISABLE BUTTON
DISABLE ITEM
DISPLAY RECORD
DISPLAY SELECTION
During
ENABLE BUTTON
ENABLE ITEMQ

Lj



4. Click on the previous Procedure window (Procedure :
Disable All), select the entire procedure as written in
the procedure area, and choose Copy from the Edit
menu.

5 . Click on the blank Procedure window (Procedure :
Enable All) and then choose Paste from the Edit menu .
4th Dimension copies the Disable All procedure into
the procedure area. You can now simply edit this
procedure .

6. Select the first three letters of the first DISABLE ITEM

command and type EN to change the command to ENABLE
ITEM .

You could also use 4th

	

7. Repeat step 6 for all five DISABLE ITEM commands.
Dimension's Search and Replace
feature to perform this edit

	

8. Edit the comment in the first line to read :
automatically .

'Enables all menus

You have now created your second global procedure .
Enable All is now available for use as a subroutine, to
undo the effect of Disable All .

Editing a global procedure
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r

	

File Edit Environment Design Search

Keywords

Structure for NEW PERSONNEL 6

4 - EMPLOYEES i

Last Name
First Name
Start Date
Salary
Title
Department Code
Employee Number
Review Info

ABORT
Abs
ACTIVATE LINK
ADD RECORD
ADD SUBRECORD
ADD TO SET
After
ALERT

Procedure : Disable RII

=0 Procedure : Enable All
'Enables all menus

ENABLE ITEM(1 ;0)
ENABLE ITEM(2,0)
ENABLE ITEM(3 ;0)
ENABLE ITEM(4,0)
ENABLE ITEM(5 ;0~ I

Routines

Figure 9-8
Edited commands

You will use both of these subroutines in the Addempl
procedure, the procedure that will be called by the Add
Employee menu command .

Creating the Add Employee procedure
You are now going to write the procedure to add an
employee record to the database .

To instruct 4th Dimension to add a new record, you need
to specify the file and the layout to use, and then you
will issue the ADD RECORD command. You will use the
Disable All and Enable All procedures you created . And
you will set the initial conditions for the variable
buttons you created on the EmployeeEntry layout. These
initial conditions and the way they are handled will make
the OK button work the way you want it to work . See
Chapter 8, "Using Layout Variables ."



You have already seen how 4th Dimension allows you to
enter commands and other elements of a procedure by
selecting them from one of the three panels on the
bottom half of the Procedure window . Your own global
procedures have been added at the end of the list of
commands and functions . You can scroll to the end of the
list in the Routines panel to see them and select them .
Note also that if you want to use the current file
displayed at the top of the file column, you can enter it
by selecting it. If you need to use a different filename,
you can change the current file by clicking either of the
arrows next to the filename .

The following steps do not specify whether to select or
type in the elements of the procedure . You will quickly
decide which method works best for you .
1 . Open a new global procedure window. Type Addempl for

the procedure name and choose Listing for the
procedure type .
Addempl is the procedure name you will specify when
you create a custom menu .

2. Enter Disable All as the first command in your procedure .
You created this procedure to disable the menus during
the data entry process . Remember that you can enter
this subroutine by selecting it from the end of the list
of routines .

Creating the Add Employee procedure
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3. Define the file to use for this record by entering
DEFAULT FILE([EMPLQYEESJ)

The DEFAULT FILE command establishes a default file
for the remainder of the procedure . You can omit a
filename specification in later commands . Notice that
the filename is surrounded by both parentheses and
brackets .
If you should omit any necessary part of a command, 4th
Dimension displays large dots on either side of the
incorrect statement (see Figure 9-9) . When you correct
the statement and press Enter (or move the insertion
point to a new line), the large dots are removed .

=p	Procedure: Rddempl
D1sa /e 4//
	DEF AULT F ILE [EMPLOYEES] .

Keywords

I
4-

	

EMPLOYEES 4
Last Name
First Name
Start Date
Salary
Title
Department Code
Employee Number
Review Info

Routines

Date
Day number
Day of
Dec
DEFAULT FILE
DELETE DOCUMENT
DELETE RECORD
DELETE SELECTION

Figure 9-9
Large dots around an Incorrect command

4. Define the input layout you want to use by entering
INPUT LAYOUT("EmployeeEntry")

EmployeeEntry is the name you gave to the input
layout you designed for this file .



5 . Set the Accept and Don't Accept button variables you
have defined for this layout by entering the following :

xOK'-O
xNext.-1
xCancel:=0

You will use these entries in a condition statement
later on. Note that the values are assigned by the
assignment operator := not by an equal sign .

6. Click the zoom button so that you have more room to
work .

7 . Now define a "While" loop so that the ADD RECORD
command is active as long as the OK and Cancel buttons
have not been clicked by entering the following :
While((xOK=O)&(xCancel-0))
ADD RECORD
End While
The combined condition keeps the loop active as long
as neither OK nor Cancel is selected by the user . Note
that the equal sign is used here to create the
conditions . The ampersand (&) is used for the logical
And in the conditions .
Note also that you don't have to indent ADD RECORD .
Simply enter it at the left edge of the listing editor,
and 4th Dimension indents it for you . This indicates
that it is a dependent command (dependent on the
higher-level While loop) .
ADD RECORD adds a blank record to the file and makes
it the current record . As long as the user clicks the OK
and Next button to accept the record, ADD RECORD
creates a new blank record. When the user clicks
either OK or Cancel, the loop is closed and no blank
record is added .

8. Finally, enter Enable All to make the menus active again .

Creating the Add Employee procedure
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Your completed procedure looks like this :

Figure 9-10
The completed Add Employee procedure

Seeing the procedure in action
Before you continue, you want to see whether your
procedure works . 4th Dimension provides a menu
command to test procedures in the User environment . This
is a good opportunity to use it to see if your handling of
the OK, OK and Next, and Cancel buttons does what you
want it to .
1 . Choose User from the Environment menu .
2 . Choose Execute Procedure from the Special menu .

4th Dimension displays the Execute procedure dialog
box. All the global procedures you created are listed in
the procedure area .

3. Select Addempl and click Execute .

Procedure : Addempl J-
Disable X411

DEFAULT FILE(EEMPLOYEESE)
INPUT L AYOUTC Employ eeEntry ")
xOK :=0
xNext :=1
xCancel :=0
While ((xOK=O)&(xCancel=0))
ADD RECORD

End while
Enable X411

Keywords F

	

EMPLOYEES

	

4 Routines

= 4 Last Name Q Uppercase
If First Name USE ASCII MAP
Else : .: . ; Start Date USE SET
End if Salary Variance
Case of Title Year of

': Department Code O abA A/I

End case liliii Employee Number &7..b .4/I

While Q Review Info ,4

	

n~ol



Euecute procedure . . .

Disable All

Enable All

Adderri i1

Cnnce

Euecute

Figure 9-11
The Execute procedure dialog box

4th Dimension begins the procedure, disabling the
menus and displaying the input layout you have
designed .

4. As this is just a test of your procedure, you can enter
nonsense data. You must enter a unique employee
number and a valid department code . Enter 26, ART,
3117187, Jones, John, Engineer 1, and 35000.

5 . Click OK .

4th Dimension accepts the record and displays it in the
output layout. Your procedure works!
Of course, you knew it would .
In particular, you see that your OK button takes you
out of the data entry procedure, as you want it to. Feel
free to execute the procedure again to see that OK and
Next accepts the record and displays a blank record
for entering another new record and that Cancel takes
you out of the procedure while not accepting the
record. In every case, the menus are first disabled and
then enabled.

6. Choose Show All from the Select menu to display all
the records .

Seeing the procedure in action
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Further information
To obtain a printed version of your procedure, choose
Print from the File menu . 4th Dimension prints the
procedure in the active Procedure window .



Chapter 10
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When you create a custom application, you can create a
set of custom menus to operate the program . Your user
can then use your application just like any other
Macintosh program .

Suppose you decide your personnel application needs the
following menus and menu items :

In this chapter, you will learn how to use 4th Dimension's
Menu editor to create these custom menu titles and menu
items. In addition, you will see how to instruct the Add
Employee menu item to call the Addempl procedure you
created in the previous chapter. Every custom menu
requires a procedure to call to carry out the command . The
menus you create in this chapter will not work until you
create procedures for them .

This chapter begins where the previous tutorial leaves off .
To follow the tutorial step by step, start 4th Dimension
and open the New Personnel 7 database .

Getting to the Menu editor
You create, preview, and edit custom menus in the Menu
editor .

To get to the Menu editor :
1 . Choose Menu from the Design menu .

4th Dimension displays the Menubars dialog box .

File Departments Employees Reports Utilities

Quit Add Department Add Employee Monthly Calculator
Modify Information Modify Information Quarterly
Modify from List Modify from List
Remove Department Remove Employee



I

	

I.

	EMF
Last Nam
First Nan
Start Date
Salary
Title
Departmen
Employee
Review Inf

Structure for NEW PERSONNEL 7

Menubars . . .

New

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Cancel

ff£7 '>i>

	

)

Figure 10-1
The Menubars dialog box

Design

This dialog box will eventually display all the names
for the custom menus you create for this database . You
can then select the one you want to edit . At present,
because this is your first custom menu, the Menubar
display area is blank .

2 . Click New .
4th Dimension displays the Menu editor . Because it is
your first menu, it is titled Menubar #1 . (You cannot
change this name .)
On every menu bar, 4th Dimension automatically enters
the File menu as the first menu . It contains one menu
item, the Quit command .

Getting to the Menu editor
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3 . Select the File menu title .
As you can see, the Menu editor displays the items on
the selected menu . In this case, there is only one item,
Quit, and there is no procedure . The absence of a
procedure tells 4th Dimension that this is a command to
quit the program .

4. Pull down the File menu on the far right side of the
screen .

File
Quit

File Edit Environment Design Menu

File

Password :

Menus

Structure for NEW PERSONNEL 7

Quit

Menuber #1
Items Procedures

Figure 10-2
The Quit command has no procedure

This menu preview allows you to preview the selected
menu. The preview shows the layout, order, and style
of the menu items .



Entering menu titles and items
You create the menus you want to use by entering the
menu titles in the order you want them to appear in the
Menus column . Then you enter the items for each menu in
the Items column . For each menu item (except Quit), you
enter a procedure name in the Procedures column .

The menus you create appear across the top of the screen
in your application . The Macintosh automatically shows
the Apple menu and the Edit menu .

To create a custom menu :
1 . Choose Append Menu from the Menu menu .

A blank box containing the insertion point appears in
the Menus column.

2. Type Departments .

This is the first of your custom menu titles . You will
enter the items for this menu later .

3 . Double-click in the Menus column just below the
Departments menu title .
Double clicking creates another menu title box, just as
if you had chosen Append Menu again .

4. Type Employees and then double-click below this menu
title to create another blank menu title box .

5 . Type Reports and this time press Return .
Pressing Return also creates a blank menu title box .

Now you have finished entering your custom menu titles .
You can go on to enter the items for each title and the
procedure name for each item .
6. Select the Employees menu title .

Use the scroll bar to move this menu title into view, if
necessary, before selecting it .

7 . Choose Append Item from the Menu menu .

Entering menu titles and items
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A blank item box appears in the Items column and a
blank procedure box appears in the Procedures column .

Flguro 10-3
Appending an Item

4th Dimension always adds both these boxes at the
same time because each menu item must have a
procedure entered in the Procedures column .

8. Type Add Employee in the item box and then press
Return .
The insertion point moves to the procedure box .

9 . Type Addempi and then press Return .
Addempl is the name you gave the procedure you wrote
to add an employee record to the database .
Another item box and procedure box are added on the
next line .

You get the idea . You type in the menu item as you want
it to appear and then enter a procedure name for each
one. When you have finished, the Menu editor looks like
this :

# 1Menubar J=
Menus

	

Items

	

Procedures

File
Departments
Employees
Reports

line
i4 Enabled

Password :)

Keyboard : Bold
Italic
Underline
Outline
ShadowI



Figure 10-4
Completed menus

You create the menu items for each menu in exactly the
same way.
It does not matter in what order you create the custom
menus and the procedures they use . In the case of Add
Employee, you created the procedure first and then the
menu item that uses the procedure . You created the menu
items for modifying, modifying from a list, and removing
an employee record before creating the procedures . You
merely need to write down the procedure names you use
for each menu item so that you can give the correct name
to each procedure when you write it.

Changing the style and adding a shortcut
On the lower half of the Menu editor window are
commands to change the look and function of each menu
item . You anticipate that the users of your application
will most often choose Add Employees . You decide to
provide some visual emphasis for the menu command and
add a keystroke to start the command as well .
1 . Select the Add Employee menu item .

Changing the style and adding a shortcut
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2. Click the Underline check box .
This causes the menu to display Add Employee with an
underline .

+ Special note; Underlining is shown here for demonstration
only. Apple's Human Interface Guidelines suggests reserving
font and style changes for only those menu items that result in
font and style changes in the application .

3. Click the Keyboard check box .
This alerts 4th Dimension that you want this menu
command to be accessed by a keystroke as well as by
choosing the item from the menu .

4 . Click the Keyboard entry box and type N .
This makes the keystroke Command-N .

5 . Preview the menu display by popping down the menu
preview on the far right of the menu bar .

Figure 10-5
Previewing a modified menu



You have now made it possible to use the Command-N
keystroke combination instead of the menu to start the
process that adds an employee record to the database .

Previewing the menus
and adding a picture
After you have entered all the menu titles, menu items,
and procedure names you want to use on your custom
menus, you will probably want to see how they look . As
you remember from Chapter 3, each set of menus has a
different picture associated with it . You use 4th
Dimension's Menu editor to preview the menus and to
paste a picture for use with the menus .
1 . Choose Show Custom Menus from the Menu menu .

4th Dimension displays the current menu bar along
with a blank screen and message .

2. Click and hold the Employees menu that you have just
created .

Employs ..:siC File Edit Departments

Paste a picture o use with this menu . Click anywhere in the window to exit .

p

Reports

yee

	

N

Figure 10-6
Previewing the custom menus

Previewing the menus and adding a picture
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Choosing a menu command from this screen does not
activate the command. You must be in the Custom
environment to start a command from a custom menu .

3. If you have a picture in your Clipboard, you can paste
it here. If you do so, each time this menu bar is shown,
the picture will be displayed also .
Use this feature of 4th Dimension to personalize your
database applications with designs, patterns, and
pictures that suit the company, person, or department
that will be using the application .

4. Click anywhere in the screen below the menu bar to
return to the Menu editor .

Further information
When you looked at a finished application in Chapter 3,
you saw two different menu bars, each with several
menus . To see the procedures that operate the commands,
you can open the Menu editor and see the procedure
names entered there. Then simply open the Procedure
editor and read the procedures you are interested in .

To reach the Design environment, you must enter the
password Manager when you start the program and then
quit the Custom environment. Then use the Environment
menu to go to the Design environment .

Menu items are automatically enabled when you enter
them in the Items panel . If you want to disable a menu
item, click the Enabled check box to turn it off. It
remains disabled until you click Enabled again .

You can enter a line between menu items by clicking the
Line check box . This can effectively separate menu items
into groups of commands for the convenience of the user .
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You have several tasks that you want performed when a
record is added or updated . You want the salary figure in
the Departments file to be the total for all employees in
that department ; and you want to set a range for the
Salary field to detect data entry errors .

To perform these processing tasks, you use what 4th
Dimension calls Layout procedures, that is, programming
associated with a particular layout. In this chapter, you
will learn how to write such a procedure for your
EmployeeEntry input layout .

When you use a layout for entering, printing, importing
or exporting data, 4th Dimension executes the Layout
procedure . In fact, the Layout procedure is executed
before, during, and (if the record is not canceled) after a
layout is displayed. The procedures are executed in the
order in which they appear in the listing or in the
flowchart .

As you learn about creating this Layout procedure, you
will be introduced to 4th Dimension's execution cycle.
Writing procedures in relation to the execution cycle is
not mandatory; instead, it is a way to optimize
performance. The execution cycle lets you control how a
procedure is executed, either before, during, or after a
layout is displayed .

The execution cycle for an input layout is different from
that for an output layout . In this chapter, you will become
familiar with the input execution cycle . In the next, you
will learn about the output execution cycle .

This tutorial begins where the previous chapter leaves
off. To follow step by step, start 4th Dimension and open
the New Personnel 8 database .



The input execution cycle
The Layout procedure is executed once before a layout is
displayed on the screen, each time a field value is
entered or edited, or a button is selected, and once just
before a record is accepted . The input execution cycle
allows you to specify when a command is to be executed :
•

	

Before: before the layout is displayed
•

	

During: when an entry is made in a field or some other
action is taken

•

	

After: after OK is clicked

It is not necessary to use the execution cycle when
writing procedures for 4th Dimension. However, if you
specify statements to be executed before, during, or
after, they are not executed every time the Layout
procedure is executed, but only when indicated .

The flowchart in Figure 11-1 shows the execution cycle
tests for a typical input layout procedure .

The input execution cycle
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yes

Executes any statements
in If (After)

Figure 11 . 1
A flowchart of the Input execution cycle

Modifying the automatic link procedure
You saw in Chapter 6, "Using Linked Files," that 4th
Dimension automatically creates a procedure for assigning
values via the link . This occurs only when you create a



A File procedure is associated
with a file, like a Layout
procedure is associated with a
layout,

layout for the linking file that includes values from the
linked file .
In this chapter you are going to modify this procedure,
making the terms clearer before going on to write the
rest of the Layout procedure . Start in the Design
environment .
1 . Choose Procedure from the Design menu to display

the Procedure dialog box .
You are familiar with the dialog box from Chapter 9,
"Using Global Procedures ." This time, however, you
will use this dialog box to open a Layout procedure .

2 . Double-click on File/Layout Procedures and then on
each of the filenames that appear .
4th Dimension expands the files to display the layout
names of each of the layouts you have created. You
will select one of these layouts to reach the
Procedure editor . A layout has only one procedure
associated with it .

Procedure . . .

Name :

h

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

S F1
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

4

N t.' € .€3

Open
3

Done

r
0
m

Figure 11-2
The Procedure dialog box with filenames expanded

Modifying the automatic link procedure 167
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3 . Select EmployeeEntry and then click Open .
4th Dimension displays the Layout Proc . :
EmployeeEntry window, which shows the procedure
you first saw in Chapter 6 .

=o
LOAD LINKED REGORD(Department Code)
A08 :=[DEPARTMENTS[Department Name
A09 :=[DEPARTMENTS]Manager

Loyout Proc . : EmployeeEntry

I

Figure 11-3
The Layout Proc, : EmployeeEntry window

4 . Click the zoom box to expand the window .
The first thing you want to do is change the variable
names to something more meaningful . This will make
them recognizable when you look at them again .

5 . Select AG8 and type xDepartment over it .
+ Note: A variable can be 11 characters long at most, and it can't

be the same as a field name .
6 . Select AG9 and type xManager over it .
7 . Choose Layout from the Design menu, select and open

the EmployeeEntry layout .
You must change the variable names on the layout as
well .

8 . Double-click on the AG8 variable and change the
variable name in the Format of variable dialog box to
xDepartment .

Keywords 4- 4 Routines

Last Name ABORT
If
Else
End if
Case of

End case

First Name
Start Date
Salary
Title
Department Code
Employee Number

Abs
ACTIVATE LINK
ADD RECORD
ADD SUBRECORD
ADD TO SET
After

While Review Info 'nl ALERT



9 . In the same way, change AG9 to xManager.

layout Proc . : EmployeeEntry
LOAD LINKED RECORD(Department Code)
xDepartment :=[DEPARTMENTS]Department Name
xManager :=[DEPARTMENTS]Manager

00

0

dl~ild

C

Y

EMPLOYEE INFORMATION

Employee Number

Start Date

Last Name

First Name

Title

Manager

IStart Date

PERFORMANCE REVIEWS :

Em to

	

Department Code

Department Name

(Last Name

First Name

ITitle I
(x ana	

Salary Salar

IDepartr

R

Layout : EmployeeEntry
N

Figure 11-4
The changed variable names

10. Close the Layout window .
11 . Select the three lines of the modified procedure and

then choose Copy from the Edit menu .
You will use these lines several times in the full
procedure .

Writing procedures for Before
Writing procedures for Before is useful primarily for
initializing variables and setting default values for fields .
You are going to initialize a variable depending on
whether this is a new record or an old record, and
display a message in a field .

Writing procedures for Before

	

169



170

	

Chapter 11 : Using Input Layout Procedures

You set the procedures for Before inside an If statement
so that they will execute only when Before is true .

1 . Click just to the left of the first word (LOAD) in the
procedure and press Return three times .
This gives you some room to start .

2. Click the top line, then click If in the Keywords panel .
Then type (Before) and press Return .

3 . Press return two more times and click on End if in the
Keywords panel .
It's always a good idea to enter the End if statement
immediately after you enter the If statement . You then
insert the commands you want between the two
statements .

4 . After If(Before), enter If(Department Code=") . Then press
Return twice and enter End if ; that is, "if the
Department Code field is empty ."
A blank Department Code field will occur only on a
new record. The next statements will apply to new
records. The statements assign a message to the
xDepartment variable for a new record and set a value
for a new variable .
Note that you can enter Department Code by clicking on
it in the middle panel .

5 . Just beneath if(Department Code="), enter :
xDepartment :="Enter Department Code . . ."
This displays "Enter Department Code . . ."in the variable
area until the department code is entered . The :_
symbol is the variable assignment operator. Do not use
the equal sign .



6. Enter xNew :=1 .
This variable (created "on the fly") is set to equal 1 for
a new record . Later, you can use If(xNew=1) to control
instructions for handling a new record and to leave old
records alone .

7 . Enter Else.
Here is the first part of the If statement :

Figure 11-5
The first part of an if(Before) statement

The instructions you have entered to this point apply
only to new records (blank Department Code field) .
"Else" means to perform the next instructions if
there is an entry in the Department Code field (that
is, if the record already exists) .

8 . Now paste the Load Linked Record instruction at this
point.
This puts the department name and the manager's
name in their respective fields when the layout is
displayed.

Writing procedures for Before
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If (Before)
If (Department Code="")
xDepartment :="Enter Department Code . . ."
xNew :=1

Else

End if

End if
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9 . Enter xNew :=O .
You want this variable to be zero if it is an existing
record .
Your completed Before statement looks like this :

Figure 11-6
The completed If(Before) statement

Writing procedures for During
Writing procedures for During is useful primarily for
checking and verifying a field value and for loading a
linked record. You are going to use a modified LOAD
LINKED RECORD command to display a Choices List of
department codes during data entry, and you will
establish a test for valid entries for the Salary field .
1 . Below the last End if statement, enter If(During) and

(after a few blank lines) End if .
This If statement will contain the operations to be
executed when During is true .

~_Loyout Proc . : EmployeeEntry
If (Before)
If (Department Code="")
xDepartment :=Enter Department Code . . ."
xNew :=1

Else
LOAD LINKED RECORD(Department Code)
xDepartment :=[DEPARTMENTS]Department Name
xManager :=[DEPARTMENTS]Manager
xNew :=0

End if
End if



Second argument follows
semicolon

Filename in panel heading

Change file arrow

2 . After If(During), paste the Load Linked Record procedure .
Now you will modify the procedure by adding a second
field name to the Load Linked Record argument . This
modification instructs 4th Dimension to display a
Choices List when the linking field has the Q wildcard
entered into it .

3 . Click between Code and the closing parenthesis and
type a semicolon .

4 . Click the right arrow in the middle panel until
Departments is displayed in the panel heading .

5 . Click on Department Name to enter both the filename
and the field name as the second argument in the LOAD
LINKED RECORD command .

Figure 11-7
Modifying the Load Linked Record command

Writing procedures for During
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xNew :=1
Else
LOAD LINKED RECORD(Department Code)
xDepartment :=[DEPARTMENTS]Department Name
xManager :=[DEPARTMENTS]Manager
xNew :=0

End if
End if

""

If (During)
LOAD LINKED RECORD(Department Code ;[DEPARTMENTS]Department
xDepartment :=[DEPARTMENTS]Department Name
xManager :=[DEPARTMENTS]Manager

Name)
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You have now established the instruction that allows
the user to enter the wildcard symbol (®) in the
Department Code field to see a list of department
codes and department names available from the linked
file. The user can then select from this list to enter the
department code in the field .

6. To provide a range check for the Salary field, enter
these four lines of code on the next four lines :
If((Salary>125000)I(Salary<0))

ALERT("Please enter a salary between zero and $125,000 . Thank
you.")

REJECT(Salary)

End if

The If statement tests the entry in the Salary field . If it
is greater than 125000 or less than zero, 4th
Dimension displays the Alert message you have entered
and rejects the entry in the Salary field. The insertion
point remains in the field for editing .
Of course, if the value entered is between zero and
125000, the Alert and Reject commands are not
activated .
Your completed During procedures look like this :

Figure 11-8
The completed If(During) statement

J-Layout Proc . : EmployeeEntry
If (During)
LOAD LINKED RECORD(Department Code ;[DEPARTMENTS]Department Name)
xDepartment :=[DEPARTMENTS]Department Name
xManager :=[DEPARTMENTS]Manager
If ((Salary >1 25000)I(Salary <0))
ALERT( Please enter a salary between zero and $125,000 . Thank you .")
REJECT(Salary)

End if
End if



Writing procedures for After
Writing procedures for After is useful primarily for
copying a value from one field to another and for
updating a linked record. You are going to update the
Total Salaries field in the Departments file after all the
information has been entered and OK is clicked .
1 . Enter If(After) and (after a few blank lines) End If.

This If statement will contain the operations to be
executed when After is true .

2. Within the If(After) condition, you first enter the
procedure to calculate a new Total Salaries figure for
the Departments file :
[DEPARTMENTS]Total Salaries :=
[DEPARTMENTS]Total Salaries+Salary

SAVE LINKED RECORD(Department Code)

Note that this procedure first adds the value in the
Employees file Salary field to the value in the
Departments file Total Salaries field. Then it saves the
record with the new total .

3 . Next enter another If statement :
If(xNew=O)

LOAD OLD LINKED RECORD(Department Code)

[DEPARTMENTS]Total Salaries :=
[DEPARTMENTS]Total Salaries-OId(Salary)

SAVE OLD LINKED RECORD(Department Code)

End If
This statement tests whether the user has modified an
existing record and, if so, subtracts the value in the

Writing procedures for After
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old record from the previous value in the TotalSalaries
field in the Departments file . Then it saves the old
Departments record . This ensures accuracy when an
employee is moved from one department to another .
4th Dimension keeps track of both a record and a copy
of the record when a record is modified . The SAVE OLD
LINKED RECORD command saves the original linked
Departments record, and the Old function identifies the
salary value in the original Employees record .
The complete After portion of the procedure looks like
this :

-p	layout Proc . : EmployeeEntry	 ~_

If (After)
[DEPARTMENTS]Total Salaries :=[DEPARTMENTS]Total Salaries+Salary
SAVE LINKED RECORD
If (xNew=O)
LOAD OLD LINKED RECORD(Department Code)
[DEPARTMENTS]Tota1 Salaries :=[DEPARTMENTS]Total Salaries-Old(Salary)
SAYE OLD LINKED RECORD(Department Code)

End if
End if

Figure 11-9
The completed If(After) statement



Further information
Before, During, and After are internal functions of 4th
Dimension. They can be either true or false. They are all
set to false when no layout procedures have been called .
When you call an input layout, 4th Dimension sets Before
to true; if you have programmed any operations to take
place when Before is true, 4th Dimension executes them
before it displays the input layout .

During is set to true whenever you modify a field and
move to another field, choose a command from a menu,
select from a list of choices, or click a button or box .
These are called events, and they call the Layout
procedure each time they occur . If you have programmed
any operations to take place when During is true, 4th
Dimension executes them after the event .

After is set to true only when you click an Accept button
or press Enter . If you have programmed any operations to
take place when After is true, 4th Dimension executes
them after it accepts the record .

Further information
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Header

Detail

Grand total

One of the major functions of a database is to produce
various reports from the information . The personnel data
that you are storing can be used to produce reports of
great interest and usefulness to your company . You can
provide a report that consists of a list of employees,
together with their salaries, divided into groups by
department. You can provide a list of employees arranged
by start date that identifies whether each participates in
the company stock and savings plans . You can provide the
average performance rating for employees for each
department over the past year and include a graph of the
information .

You have decided to create a standard report showing the
employees, their salaries, and the total salaries for the
department (see Figure 12-1),

20 .3555

General xatta~eaea1

Figure 12-1
The final report

CONSUMER PRODUCTS EMPLOYEES

To 1 for Departmerr4

Toml for Depermment
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01120187

$11224400

$706,661 00

Subtotals on sort field break

Depemttnt Nave Name Salary

Acconb PgOle Ardenon, Nathan 39500

Acoonb Pgalkt Smith, Mary 26650

Duita Adler, Frank 29750

Date Andrew, Miclael 22500

Des*a Eat n1,bhn 27545

Des i Dor on, H!n 31500

Date W11] ez on, Tyler 41550

Protut xaa. s it Franklin, Maaha 32975

Proiut xar~erat Smith, Sally 45679

Proltet xaageaeat Tracy, 3oan 335%0

Toe1 for Depermeni $66,150 00
\

Atton b Baeinlk Netrbn, Ker lal

Acconts Reaivalk Smith, Safy 35567

Total for Depamnnt\ $74,117 00

Alr i tretio∎ IDevn,Tom 28500

$28,500 .00Toil for Deperonnt\



To create this report, you will design an output layout
for printing the report . You will write layout procedures
to control any special processing you need to perform .
The output layout and the procedures work together to
create the report. As you work with the layout and the
procedures, you will be introduced to the output
execution cycle.
In addition, you will create a global procedure that
performs the necessary sorting of the records and issues
the Print command .

The output execution cycle
The Layout procedures you write affect the printed
output, screen display, and data export that use the layout
they are associated with. The output execution cycle
allows you to clearly specify when a command is to be
executed :
•

	

In header: Before 4th Dimension prints the header
portion of the output layout . This happens once when
the print routine begins and once at the top of each
page .

•

	

Before: Once before each record is printed .
•

	

During: Once before each record is printed .
∎ In break: Before 4th Dimension prints the break

portion of the output layout . This happens when the
sort field value changes and before a footer is printed .

•

	

In footer: Before 4th Dimension prints the In footer
portion of the output layout . This happens at the end of
each page .

The output execution cycle
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Executes any statements

Figure 12-2
A flowchart of the output execution cycle
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yes

Executes any statements
in If (In header)

yes

Executes any statements
in If (Before)

yes

Executes any statements
in If (During)

l

yes

Executes any statements
in If (In break)

yes

l

Executes any statements
in If (in footer)



The flowchart in Figure 12-2 shows that an output layout
procedure tests to determine whether In header, Before,
During, In break, and In footer are true each time the
Layout procedure is executed, executing any statement
associated with any true part of the cycle . Then any
statements outside these tests are executed .

The output execution cycle is independent of the
indicators for header, detail, break, and footer as shown
on the layout . For example, an element entered in the
header area on the layout will print at the top of each
page even if there are no procedures at all .

The different parts of the output layout are explained in
the next section .

Designing the output layout
You created an output layout to display your records on
the screen in Chapter 4, "Creating a New Database ." This
time, you will create an output layout designed for
printing . Start in the Design environment .
1 . Create a new output layout named EmployeeReport

and include the Department Name, Last Name, and
Salary fields in that order (see Figure 12-3) . Use the
layout pattern on the top left of the pattern choices,
as you did in Chapter 4 .
4th Dimension creates the Layout procedure that
loads the linked record from the Departments ale .

2 . Select the Layout window and expand it .
3 . If you are using a LaserWriter Plus printer, choose

Select All from the Edit menu and then choose Times
from the Font menu .

Designing the output layout
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=p	 Layout: EmployeeReport	 P:i_

dl~dd

4th Dimension changes all the type to Times, an
attractive, readable font for use on your LaserWriter .
If you are using another printer, omit this step or
pick another font size that shows the entire layout on
the screen .

File Edit Environment Design Font Style Layout Colors

r-~
L-J
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partment Name

	

at Name
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Figure 12-3
The three fields In the layout

ast Name

	

salary

•

	

100

• 150

-200

250

4, Drag the Footer marker down to 220 and the Break
marker down to 170 (see Figure 12-4) .
The Footer marker defines the bottom of the area that
4th Dimension will include in each footer . Typically,
you use footers for page numbers and running
comments or titles .
The Break marker defines the bottom of the area that
4th Dimension will include in each break . Typically,
you use breaks to print subtotals and explanatory
text .



You can drag either the letter or the triangle symbol .

The dotted line for each marker shows where on the

layout you can place elements to be printed at the

break and in the footer .

5 . Drag all the elements on the layout (they remain

selected) so that the bottom line is at about 110 .

6 . Finally, drag the Detail marker down to just below

the second line of the layout (just below 110), and

drag the Header marker until it is between the

column header row and the field name row (about 85) .

The Header marker defines the bottom of the area 4th

Dimension will include in the header at the top of

the page. Typically, you use headers for running

titles, column headers, page numbers, or date and

time stamps.

The Detail marker defines the bottom of the area 4th

Dimension will print once for each record in the

selection you print. Typically, you use this area for

data drawn directly from the records .

dl~ibl
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Figure 12-4

The layout after markers have been dragged

i,
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You have now defined areas on your layout for
elements to be printed in the header, detail, break,
and footer areas of your report (see Figure 12-4) .
Anything entered in these areas prints at the
appropriate time .

7 . Change the AG1 variable to xDepartment and make it
slightly smaller .

8 . Change the column heading Last Name to simply Name .
9 . Delete the Last Name field and enter a variable

named xName.

You selected the field name for inclusion on the
report only so that the layout would provide room for
this element. You are going to write a procedure for
the xName variable to join each employee's first and
last names .
Everything in the detail area (between the Detail
marker and the Header marker) prints once for every
record. The xDepartment variable will print the
department name, the xName variable will print the
employee's name, and the Salary field will print the
salary value one time for each record .

10 . In the Header area, above the column headings, enter
a report title (Consumer Products Employees), a variable
for the date (xDate), and a variable for the time (xTime) .

11 . In the Break area (between the Break marker and the
Detail marker), enter variables for salary subtotal
(xSalary) and a text string (xStr) . You will program
these variables to display the department subtotal or
the company total depending on the "level ." (Each
sort creates another level within which a subtotal can
be calculated. All the records are included in level
zero. This level zero is called the "End of file
break.")



12 . In the Footer area (between the Footer marker and
the Break marker), enter a variable for the page
number (xPage) and identifying text (Page :) .

13 . Again, if you are using a LaserWriter Plus, select all
the elements again and then choose Times from the
Font menu .
This changes the font to Times for printing on a
LaserWriter Plus .

14 . Finally, select the title and change it to 18 point
Helvetica bold .
This is a better font and size for the title of the
report .

dl~dd

I jout: EmployeeReport	 Ell-

r-~
-J

CONSUMER PRODUCTS EMPLOYEES

Deparhnent Name eme
H

Page : Ix	
200

'250

	50

	

1~J	150	200	250	300	350
Rr
r1

Figure 12-5
The completed report layout
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Writing layout procedures for the report
The layout procedure for this report controls the
processing of the information during printing . As you
remember, this procedure will be executed several times
during printing. Except for one case (the xPage variable)
it is not strictly necessary to use the various tests of the
execution cycle . Typically, however, you will use the In
header, Before, During, In break, and In footer tests for
efficient processing, as shown here . The one mandatory
case is noted below .
1 . Click the close box of the Layout : EmployeeReport

window.
The window is put away and your layout is saved . The
Layout Proc . : EmployeeReport window is visible .

2 . Click the zoom box .
3 . Select AG1 and change it to xDepartment .

AG 1 is the variable 4th Dimension created
automatically. You changed it on the layout to
xDepartment .

4 . To leave room for the In header procedures, enter
several blank lines above the LOAD LINKED RECORD
command.
This is not strictly necessary, but people normally
write listings in the order in which they appear on
the layout. This makes the programming easier to read
and understand .



5 . Within an If(In header) statement, write the procedures
that control the date and time variables :
If(In header)
xDate :=Current date
xTime :=Time string(Current time)
End if

This instructs 4th Dimension to print the date and
time whenever In header is true .

	.• Note: Again, it is not strictly necessary to include
xDate:=Current date and xTime :=Time string (Current time) in
the In header instructions . Because the variables are entered in
the header area, they will print in the header . Your instruction
could be placed outside the In header test and still work
correctly .

6 . Enter an If(Before) statement around the automatic
linking procedure you have modified .

7 . Above the LOAD LINKED RECORD command, enter the
statement that reenters the department code :
Department Code :=Department Code

This statement is necessary to activate the link .
8 . Insert into the same If(Before) statement, after the

LOAD LINKED RECORD command, the procedure for
the xName variable :
xName:=Last Name+", "+First Name

This instructs 4th Dimension to print the value from
the Last Name field, then a comma and a space, and
then the value from the First Name field . This is
better than using two fields on the layout because
these instructions enable you to control the space
between the names .
Figure 12-6 shows what the first portion of the
layout procedure looks like on the screen .

Writing layout procedures for the report
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Figure 12-6
The If(In header) and If(Before) statements

Note that you have not included any procedures for
If(During) ; none are necessary .

9 . Within an If(In break) statement, write the
procedure that controls the xSalary and xStr
variables :
If(In break)

xSalary:=Subtotal([Employees]Salary)
if(Leve1=1)

xStr:="Total for Department :"
Else

xStr:="Total for all Departments :"
End if

End if
Notice here that you use the Level command to
control whether the xStr variable prints text for the
department or for the company . The Subtotal function
calculates the total for each break, and then once at
the end of the report for all the records .

J=Leyout Proc . : EmployeeReport
If (In header)
xDate :=Current date
xTime :=Time string(Current time)

End if
If (Before)
Department Code :=Department Code
LOAD LINKED RECORD( [EMPLOYEES ]Department Code)
xDepartment :=[DEPARTMENTS]Department Name
xName :=Last Name+", "+First Name

End if

i



In the global procedure, you will define the sort
fields that cause the Subtotal function to calculate a
total for each department and then for the entire
company.

10. Within an If(In footer) statement, enter the procedure
that controls the xPage variable :
xPage:=xPage+1

+ Note. You must include this statement within the If(In footer)
test or else it will increment each time the layout procedure is
executed. In this example, without the If(In footer) test, your
first page would be numbered page 32 .

You will initialize the xPage variable in the global
procedure .

Figure 12-7 shows the second half of your layout
procedure .

Figure 12-1
The If(In break) and If(In footer) statements

Your layout procedure is now complete . You can go on
to create the global procedure that calls this layout and
the procedure you have just written .

Writing layout procedures for the report
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J=Layout Proc . : EmployeeReport
If (In break)
xSalary :=Subtotal([EMPLOYEESISalary)
If (Level=l)
xStr :="Total for Department :"

Else
xStr :="Total for all Departments :"

End if
End if
If (In footer)
xPage :=xPage+1

End if
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Writing global procedures for the report
Your global procedure needs to set the file and layout
you want printed, establish the selection (the group of
records you want to print), set the sort order for the
breaks within the report, and then reset the correct
default output layout. In addition, you want to initialize
the page number variable .
1 . Create a new global procedure called

EmployeeReport .
You did this in Chapter 9, "Using Global Procedures ."

2 . Define Employees as the default file :
DEFAULT FILE([EMPLOYEES])

3 . Name the output layout you want to use for printing .
You are using the layout you just created :
OUTPUT LAYOUT("EmployeeReport")

4 . Enter ALL RECORDS to make the selection include all
the records in the database.

5 . Enter Disable All, the global procedure you created in
Chapter 9 to disable the menus during printing .

6 . Initialize the page number variable :
xPage :=0

7 . Sort by department code and last name, both in
ascending order :
SORT SELECTION([EMPLOYEES]Department
Code ;> ;[EMPLOYEES]Last Name ;>)

This sort order arranges the records by department .
The sort break occurs when the department code
value changes. Because your layout procedure
calculates a subtotal for salary for each break, the
subtotal will be the total for each department .



You need to create one more sort level than you need

for the breaks you are using. This is required by 4th

Dimension; it gives you the ability to have the last

field's values print in a desired order without

generating a break .

8. Tell the program to print :

PRINT SELECTION

You do not need to include the filename because you

have established Employees as the default file with

the first command.

9. Reset the default output layout.

OUTPUT LAYOUT ("Data Output")

If you were to leave this instruction out, the printing

layout would become the display layout.

10 . Finally, enter Enable All to enable the menus again .

The complete procedure is shown in Figure 12-8 .

Figure 12-8

The global procedure to print the report

Your global procedure is complete. Go to the next

section to see whether it works .

Writing global procedures for the report
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~_Procedure : EmployeeReport

DEFAULT FILE([EMPLOYEES])
OUTPUT LAYOUT( "Employ eeReport")
ALL RECORDS
Disa6de RII
xPage :=0
SORT SELECT ION( [EMPLOYEES ]Department Code ;> ;[EMPLOYEES ]Last Name ;>)
PRINT SELECTION
OUTPUT LAYOUT( Data Output")
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Seeing the procedures in action
1 . Click the Close button to close and save your

procedure .
2 . Choose User from the Environment menu .
3 . Choose Execute Procedure from the Special menu and

execute EmployeeReport .
4th Dimension displays two printer instruction dialog
boxes. If you have a printer connected to your
computer, you can print your report. Or you can click
the "Preview on screen" check box on the second
dialog box to send it to the screen .

4. Click OK to start printing .
5 . Click the zoom box to see the report close up (see

Figure 12-9) .

a File Edit Environment Enter Select Report

Printing EMPLOYEES	

1 .58 :3 :3

CONSUMER PRODUCTS EMPLOYEES

Accounts Receivable

Accounts Receivable

Total for Depeitrnent :

Newton, Kendall

S th Sally

Total for Department. :

Figure 12-9
Seeing the report printing to the screen

Special

01126'87

$66,150 .00

38550

35567

$?*117 .00

You have created a working program . To include it in
your custom application, create an Employee Report menu
item that calls this procedure .

Depart neat Name Name Salary

Accounts Payable Arudersan, Nathan 39500

Accounts Payable Smith, Mary 26650



Creating mailing labels

One of the simplest and most useful of report layouts is a

mailing label layout . Using layout procedures, this layout

can be printed from the User environment to create

mailing labels for every name and address in your

database .

Assume that your database includes Last Name, First

Name, Address, City, State, and Zip Code fields for each

employee . If you were to simply place these fields on the

layout in the proper location, you would obtain a

working mailing label. However, since each field contains

entries of different lengths, there would be awkward

spaces left between the field values .

Here is a way to overcome this limitation .

1 . Create an output layout made up of three variables, one

for each line of the mailing label (see Figure 12-10) .

Figure 12-10

Designing a mailing label

Creating mailing labels 1 95

J-I Uout: MeilingLdbels

k Neme

o [A'
L_J xAddress

.
~Illl~l~ "I'll
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Notice that the variable areas have been placed in the
Detail area and that the units on the rulers have been
changed from points to inches for easy reading .

2. Create layout procedures that define each variable (see
Figure 12-11) .

Figure 12-11
The layout procedures for a mailing label

You have defined the xName variable as the value in
the First Name field, plus a space, and then the value
in the Last Name field . The xAddress variable is simply
the Address field. You could connect a space and a
Suite Number field together in this variable as well .
Finally, your xCityStZIP variable consists of the City,
State, and Zip Code fields joined together with a
comma and spaces .
Using this MailingLabels layout as the output layout in
the User environment, you can print these mailing
labels by choosing Labels from the Report menu .

J=Layout Proc . : MailingLabels
xName :=First Name+" "+Last Name
x Address Address
xCitySt2IP :=City+" "+State+' "+ZIP Code



Further information
In header, Before, During, In break, and In footer are
internal functions of 4th Dimension . They can be either
true or false . They are set to false when no output
layouts have been called .

When an output layout is first called, 4th Dimension sets
In header to true ; if you have programmed any operations
to take place when In header is true, 4th Dimension
executes them first . These same commands are executed
after each page prints, that is, at the top of each new
page .

Before and During are set to true just before each record
is printed. Operations specified to take place during
these times are executed even if your report does not
call for the printing of values from each record (called
Details) .

In break is set to true when 4th Dimension encounters
any change in the value of a sort field specified in the
program as a break field. If you have programmed any
operations to take place when In break is true, they are
executed after the last record in the previous break
group and before the first record in the next break
group. In addition, In break is true just before each
footer .

In footer is set to true just before 4th Dimension
encounters the end of each page . In this context, "just
before" means "as soon as there is just enough room to
print whatever the instructions in In footer require to be
printed." If you have programmed any operations to take
place when In footer is true, 4th Dimension executes
them after printing the last record on the page (or the
last line of a break operation) and before beginning the
next page of printing .

Further information
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linked fields . See also fields

in input layout 100-103
variables 103

linked files . See also files
access to 43-44
automatic data entry 104-105
data entry 40
described 15
linking files and 15, 99
linking procedure 99-100
selection list 40
Structure editor 24
update linked file 106-107
use of 96-99

linking files, linked files and 15, 99
Listing method 140
LOAD LINKED RECORD

command 107, 171-173,
188-189

Long Integer field type,
specifications for 52

loops, in global procedures 149

M
MacDraw 60

202

	

Index

Macintosh 512Ke, hardware
requirements 3

Macintosh interface tool

preview menus 161-162
preview modified menu 160

Menu menu, Show Custom Menus
command 161

menus
create and modify 27
customizing 35-36, 157-159
disable menu commands
procedure 141-144

enable menu commands
procedure 144-146

Modify Record command (Enter
menu) 90, 120

Move to Back icon 65
Multi-line layout 41

subfile 115, 118

N
New Field command

menu) 112
New Layout dialog box 57-58
New Record command (Enter

menu) 131
non-enterable variable type 134
number entry format 78
numbers
formats for 67
too large to display 68

Numeric field type, display
formats 67-69

(Structure

0
objects, resize 62
OK button customization 125-127

OK and Next button
customization 128-130

Open Database command (File

designing the layout 183-187
execution cycle 181-183, 194,

197
global procedure for
report 192-193

If statements 189, 190, 191
mailing labels 195-196
procedure writing 188-191
report design
procedure 180-182

P
page numbers

in the Footer marker 184
in the Header marker 185
initialize variable 192

palette tools (icons) 64
parent file 16, 17
defined 110
subfile display and 116-119

passwords
create 28
customized 35-36
for menu items 27

Paste command (Edit menu) 117
Personnel database . See Examples

disk
Picture field type 44

specifications for 52
pictures, add to custom

menus 162
primary sort field 82
print
from File menu 152
procedure to print report 193

,
creating 25 menu) 81

operators
assignment operator (;_) 133

Macintosh Plus, hardware
requirements 3

mailing labels 31, 195-196 logical AND 149
search criteria order 86

Output check box 72
output layout(s)

create 25, 70-73

Mandatory field attribute 50, 53
Menubars dialog box 155
Menu editor 27

accessing 154-155
add picture 162 described 17, 19-20

for subfiles 114-115
output layout procedures

change style of items 159-160
enter titles and items 157-159



report to screen 194

Print command (File menu) 152

Procedure dialog box 139

Procedure editor 26

accessing 139-140

procedures 21

create 26

global 138-152

input layout 164-177

output layout 180-197

Procedure type dialog box 140

Procedure window 141

linked fields and 102

processing 13, 21

Quit command (File menu) 44,

155-156

R

radio buttons 134

range checking 44

Real field type 51

specifications for 52

records

data entry 30, 38-40, 76-80

delete 81

described 10

modify 37-38, 89-92

representation of 11

search 30, 86-89

sort 30-31, 82-85

subrecords 16, 41-43, 110

subsets of (selection) 86

record selection icon 90

relational features . See linked files

Rename file command (Structure

designing the layout 183-187

mailing labels 195-196

resize an object 62

Return key 77

Revert to Saved command (File

menu) 62

runtime version 32

S

SAVE OLD LINKED RECORD

command 175-176

menu) 183

Select icon 64

selection (record subset) 86

Select menu

Search command 86

Search and Modify

command 37-38, 91

Show All command 89, 92, 151

Sort command 82

Shift-Tab key sequence,

movement in fields 42

Show All command (Select

menu) 89, 92, 151

Show Custom Menus command

(Menu menu) 161

software requirements 3

sort

Choices List 54

records 30-31, 82-85

Sort command (Select menu) 82

Sort dialog box 82-83

sort field cells 82, 83

sort order 82, 85

Special menu, Execute Procedure

command 150, 194

Standard Choices field attribute

create a custom list 54-56

described 53

starting 6-7

structure 13

of database files 14-17

Structure editor 24

Structure menu

create fields 49-51

New Field command 112

display in parent file 116-119

enter and view data in 120-122

input layout for 113-114

output layout for 114-115

overview of 110

subrecords, defined 16, 41-43,

110

subroutines 21 . See also global

System file 3

T

Tab key, movement in fields 42

Text Area icon 62, 64

Text field type, specifications

for 52

title screen 35

types. See field types or specific

field type

U

Undo command (Edit menu) 62

Unique field attribute, described 53

User environment 22, 29-32

add records 76-80

ASCII map 32

data entry and modification 30

described 29

Index
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procedures

select from list 147

Subtotal function 190

saving databases 6

screens, customized 35

Scrollable Area variable 135

search

Rename file command 47-48

Structure window

field name and type display 51

file creation 46 49

criteria order 86

records 30

subfile appearance

Style menu

112

save search criteria 87 Center command 63

Search command (Select menu) 86 text elements and 65

menu) 47-48

reports

creation 31

Search editor 87-88 Subfile field type 111

Search and Modify command (Select specifications for 52

menu) 37-38, 91 subfiles

Search and Modify dialog box 91 create and name 24, 111-112

secondary sort field 82

Select All command (Edit

create subfields

described 16-17

112-113



record searching and
sorting 30-31

report creation 31
Utilities menu, Calculator

command 44

149
button variables 133-134
character length of 168
initialize 169-172
layout variables 124, 134-135
in linked fields 103

view files 24

W, X, Y
Welcome screen 6
While loop, in global

procedures 149
wildcard symbol (®) 40

Z
zoom box 60

V
value, search criteria order 86
variables

assignment operator (:_) 133,
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